
!

SeaSonde® Remote Unit 
Operator’s Manual
SSRS-100 Product Series





Table of Contents
Site Planning! 5

..........................................................................Antennas & Cables! 5

.........................................................................Electronics Housing! 8

..............................................................................Communications! 9

Assembling the Antennas! 11
...........................................Dome Style Combine Antenna Setup! 14

............................................Dome Style Combine Antenna Parts! 14

....................................................................................5 MHz (Long Range)! 22

.....................................................Antenna FeedLightning Protection Kit! 32

Configuring the SeaSonde! 35
...............................Confirm electronics rack cable connections! 35

...............................................................................Initial Power Up! 35

.........................................................................Configure Site Information! 36

......................................................................Powering up the transmitter! 40

......................Configure GPS synchronization (SHARES systems only)! 41

..................................................................................Computer reboot test! 43

Measuring the Antenna Pattern! 45
............................................................................................Items Required! 45

.....................................................................Configuring the transponder! 46

...................Configure the Receiver and  Locate the Transponder Peak! 48

............................................Set up the transponder antenna on the boat! 51

SeaSonde SSRS-100 Operator’s Manual

1



.....................................................Set up tracking on your GPS handheld! 53

..............................................................Set up the SeaSonde to Log Data! 53

...........................................................................Measure Antenna Pattern! 53

............................................................................................Store APM data! 54

..................................................................................................Land Points! 54

............................................................................................Store APM data! 55

.........................................Re-Configure SeaSonde for normal operation! 55

....................................................Making an Antenna Pattern File! 56

Routine Monitoring! 56
........................................................via RadialWebServer Display! 56

...............................................Navigating the RadialWebServer interface! 59

...............................................via Timbuktu Pro (Screen Sharing)! 70

.............................Controlling the Screen of the Remote Unit Computer! 70

.............................Transferring Data to/from the Remote Unit computer! 73

.......................................................Viewing Vector Data with SeaDisplay! 76

..........................................................................................Viewing Spectra! 79

...................................................................................Viewing Diagnostics! 83

.......................................................................................Data Management! 92

CODAR Support Services! 97
..............................SeaSonde Training and Self-Help Resources! 97

.......................................................How to Get Technical Support! 97

....................................................Setting up a Support Services Account! 97

....................................................................................No-Charge Services! 98

.....................................................Reporting Problems to CODAR! 98

Table of Contents

2



..................................................................................Identifying a problem! 98

......................................One-click Diagnostics Using SeaSondeReports! 98

Returning Equipment to CODAR! 101
......................................................................................Procedure! 101

Appendices! 102
.......................A. Dome Combine Antenna Mounting Template! 102

..................................................................................Appendix B:! 103

............................Box Style Receive & Combined T/R Antenna! 103

......................................................................Box Style Receive Antenna! 103

.......................................................Transmit Antenna Assembly! 109

.....................................................................................12 MHz and Above! 109

..................................................................................Appendix C:! 115

....................................SeaSondeRadialSetup Default Settings:! 115

..................................................................................Appendix D:! 117

.....................................................Optional Configuration Tasks! 117

....................................................Find frequency with least interference! 117

.....................................Create a site map for viewing surface currents! 117

SeaSonde SSRS-100 Operator’s Manual

3





Site Planning
Antennas & Cables

The following are requirements for siting SeaSonde antennas to operate at maximum 
performance. It is not always possible to meet the requirements listed below. For example, a site 
may not be as close to the water as possible in order to avoid objects between the antenna and 
the water. Advanced planning and site scouting greatly benefit antenna siting. A temporary setup  
is ALWAYS recommended in order to evaluate the SeaSonde’s performance at any given 
location.
Summary of planning tasks for siting antennas
• Plan antenna location with respect to receive antenna and other vertical structures.
• Plan cable routes between SeaSonde transmitter and transmit antenna making sure that the 

cable is long enough to reach at both ends.
• Plan antenna support.
• Plan to protect against animal damage.
• Plan to protect area around antenna against tampering and vandalism.

Distance Between Antennas
The following distances are the minimum allowable between SeaSonde transmit and receive 
antennas. (Not applicable to combined transmit/receive antennas.)

SeaSonde frequency Min Antenna Separation

4.3–5.4 MHz 60 meters

11.5–14.0 MHz 25 meters

24.0–27.0 MHz 12 meters

40.0–44.0 MHz 6 meters

Distance to Water
▢ Locate antennas as close to the water’s edge as possible.  The following distances are the 

maximum allowable between a SeaSonde antenna and water:

SeaSonde Frequency Max Distance to Water

4.3–5.4 MHz 250 meters

11.5–14.0 MHz 150 meters

24.0–27.0 MHz 150 meters

40.0–44.0 MHz 100 meters
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Terrain
▢ Antennas should be located on flat or gently sloping land.
▢ Avoid locating antennas directly in front of steep hills or cliffs.

Note: Locating antennas on top of a hill or cliff is acceptable as long as the steep section is 
below the antennas.

▢ Avoid terrain that rises between the antenna and the water, like rocks, points or cliffs.

Objects Near Antennas
The following "clear area" should be maintained. Distances are minimums. The farther away 
any electrically conductive object is from an antenna, the better.
▢ Ensure that above-ground objects are at least five times their height from the antenna 

location. The taller the object, the farther away it must be.
Note:
For example, a six-meter-tall light pole should be at least
6 * 5 = 30 meters away from an antenna.
Electrically conductive objects (metal poles, wires, etc.) affect performance more than non-
conductive.

▢ Ensure that no electric power lines or transformers are within 100 meters of antennas. Avoid 
high power electric lines. Electric power lines cause radio interference.

Underground Objects
SeaSonde performance is adversely affected by nearby underground electrical conductors, such 
as metal pipes, steel reinforcement bars or cables.
▢ Ensure that there are no long (any length greater than one meter) underground electrical 

conductors within a 100-meter-radius and 10-meter-deep area below the antenna base.
▢ Ensure that there are no shorter (any length less than one meter) underground electrical 

conductors within a four-meter radius below the antenna base.
Note: Underground non-conductors do not affect SeaSonde performance.

Objects Between Antennas and Water
▢ Avoid objects that rise between the antenna and the water, like buildings or metal fences.
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Objects That Affect Antenna Performance
The following is a list of common objects that affect antenna performance. These kinds of 
objects should be kept outside the clear areas defined above.

Above-ground objects:
• metal railings or fences*
• buildings
• rocks
• cliff or steep slope BEHIND antennas
• non-SeaSonde antennas
• towers

• overhead cables
• large metal objects
• trees
• electric power lines, especially high 

voltage

Note: Mounting antennas on top of metal fences or light poles can help to mitigate the effects 
of these objects if there is not sufficient clearance.

Below-ground objects:
• metal pipes
• cables

• steel reinforcement bars

Radio Transmitters
▢ Avoid any non-SeaSonde transmitters operating in the area, including commercial navigation 

radars.

Antenna Support
▢ Plan how to support the antenna.
Antenna support depends on the characteristics of the site. If the site’s soil can be excavated, it 
is common to use a reinforced-concrete in-ground pier. Plans for such a pier are included in this 
guide. A drawing of the antenna feed is also included and shows the mounting bolt hole pattern. 
For temporary or short-term installations, the antenna can be bolted to a sturdy plywood base 
(not supplied), which sits on the ground, and stabilized with guy ropes. The base should be 
0.75–1 meters in diameter or square, with four holes drilled in the center and matching the 
antenna feed bolt hole pattern. A hinged base-plate at the base of the mast is highly 
recommended for convenience of installation and maintenance.
▢ Decide whether guy ropes will be needed.
If the support is very stable (for example, a concrete pier), guy ropes are not needed. Guy ropes 
should be made of non-conductive material. Do not use metal guy wire or cable. For long-term 
installations, Kevlar rope with UV-resistant outer braid is recommended. To reduce cost, nylon 
can be used for short-term installations. If guy ropes are needed, plan how they will be 
anchored. Simple or cork screw stakes are commonly used. Metal stakes can be used. 
Determine the required length. Guy ropes and stakes are not provided with the transmit antenna 
and must be procured separately.

Cable Protection
Animals (rodents in particular) can gnaw through cables. Plan to avoid this potential damage. 
Covering the cable with plastic split loom tubing (1 inch nominal size) is an inexpensive way to 
protect the cable. Running the cable through conduit is also an option. Conduit can be buried. 
Schedule 40 PVC pipe can be used as conduit.
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Security and Safety
People should not touch the antenna or risk tripping over the wires on the ground that radiate in 
a circle from the base of the antenna. Use a non-metallic fence, markers and/or signage, 
especially if the site is accessible to the public. A minimum keep-out area is a 7 meter radius 
circle centered at the antenna.

Electronics Housing

Dimensions

SeaSonde electronics consist of one each of a transmit and receive chassis.  Both are rack-
mountable and designed to fit industry standard 19 inch (48 cm) wide racks.  Each chassis is 3U 
(13.335 cm) tall and requires a depth of 56 cm including space for cable connections.

A SeaSonde also comes with a computer, keyboard, mouse and monitor.  Space needs to be 
provided for these items.  Unless specified otherwise, a Mac Mini computer is provided: (5.08H x 
16.51W x 16.51D cm).  Typically, a 17" monitor is provided but needs only be connected during 
user interaction.

Additional room in the rack should be budgeted for the recommended UPS and extra battery 
banks or other peripherals.

Climate Control

Depending on the transmit power, the SeaSonde will generate approximately 1000 BTU per 
hour.  This heat needs to be dissipated or displaced as well as any additional heat from other 
peripherals (DSL /cable modems, etc.) or external sources, such as the ambient air or solar 
radiation.  Ambient air temperature inside the electronics enclosure should be kept at / below 95° 
F (35° C) if possible. If ambient air temperature is consistently higher, the performance and life 
of your system may be degraded and manufacturer’s warranty will be voided.

Also, a closed system should be used to isolate SeaSonde electronics from the salt air found 
near the coast.  Additionally, if air conditioning is installed on the electronics rack within an 
exterior housing, be sure to vent warm air exhaust outside or into a room with climate control or 
volume of sufficient size to prevent overheating.

Power

SeaSondes are delivered with one of three possible input voltages: 240VAC, 120VAC or 24VDC.  
Be sure your SeaSonde electronics match your power source’s voltage. Clean reliable power is 
a necessity for SeaSonde operation. CODAR recommends using an Uninterruptible Power 
Supply in line with the computer and electronics. This will protect against unstable power and 
brown outs. The AC SeaSonde’s power consumption is approximately 600 W continuous.  Air 
conditioning and peripheral devices will add to this amount.
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Communications
Robust communications are an essential part of maintaining a SeaSonde® network.  A fast and 
reliable data connection will allow you to transfer data files, browse the remote file system, run 
commands and view/control the remote screen.  This will reduce downtime by allowing the 
operator to diagnose and fix problems sooner or even prevent problems before they affect data 
acquisition.  When working with Radio Frequency (RF) signals, the ability to view real-time 
spectral graphs is invaluable for diagnosing problems and identifying solutions.  Lastly, it is the 
responsible thing to do because most frequency-granting authorities require the ability to 
shutdown broadcast equipment immediately, if necessary.  As much as reliable power and good 
environmental controls, communications should be considered and planned well ahead of 
SeaSonde installation.

With the above ideas in mind, remember the following guiding principles when choosing your 
SeaSonde’s communications solution:

1. Data transfer should be robust with minimal dropouts or downtime
2. The upload bandwidth should be 256 kbit/s or greater for screen control
3. You should be able to find the SeaSonde computer on the internet and initiate an 

incoming connection at a moment’s notice

The SeaSonde computer allows for data transfer to the SeaSonde combine server or any file 
server that the user chooses. The best options for data transfer are SSH and Timbuktu Pro 
transfers, which are scheduled through Unix cron commands.  The following should be 
considered when planning and implementing a communications solution for your SeaSonde 
remote unit.

Public IP Address

Internet Protocol (IP) addresses are the way devices find each other over the network.  When 
making a decision about which method to use for communications, make sure that the IP 
address assigned to your computer is not private.  Private IP addresses are reserved for devices 
behind routers that share a single public IP address using network address translation (NAT).  
They will match one the following patterns:

192.168.x.x      10.x.x.x      172.16-31.x.x

If the SeaSonde Computer is assigned an IP address matching one of these patterns, then you 
will not be able to access it remotely unless you are able to implement port forwarding.  Traffic 
on port 22 (SSH) and/or port 407 (Timbuktu Pro®) that arrives at the public address is forwarded 
to the SeaSonde computer’s private address.  Not all ISPs are willing or able to provide this 
service.

Static IP Address

In addition to having a public IP address, it is also important to have a static IP address that you 
can always rely upon to contact your SeaSonde remote unit computer.  A static IP address is 
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one that will only be assigned to your computer and will not change, even when the computer is 
rebooted or reconnects to the internet. If you cannot get a static IP address, use one of these 
solutions:

Dynamic DNS Service
Domain Name System (DNS) matches name internet addresses like codar.com to 
numeric addresses like 72.41.175.235.  Dynamic DNS service allows you to choose a 
name address like mysitename.dyndns.com and then dynamically match it to your 
computer’s numeric address, even if that numeric address changes. Software runs on the 
remote computer to keep the match up to date.  There are several of these services 
available online that support Mac OS X.  The ones most often used by CODAR 
customers are www.dyndns.com and www.noip.com. Typically, you sign up for an account 
using your email address.  For each account/email address, you may get 1-5 dynamic 
name IP addresses for free.  You can get more per account/email address with a monthly 
fee.  There is rarely more than a 30 minute lag between the IP address being updated 
and the match being updated. All TCP/IP protocols can use Dynamic DNS.

Timbuktu IP Locator
Timbuktu (included on every radial SeaSonde computer) has a feature similar to dynamic 
DNS service whereby you supply your email address to the Timbuktu software on the 
SeaSonde computer and it reports the public ip with your email address to a Netopia 
server.  The service is included with the software license and does not interfere with 
dynamic DNS services but you can only use each email address once per computer and 
it only works with the Timbuktu remote control and file transfer software (no SSH, rsync, 
FTP, etc.).  This is a great secondary method in case dynamic DNS fails.

Push Data
If your remote unit computers do not have static IP addresses and the combine site has a 
fixed, public IP address, then the preferred solution is to set up your remote machines to 
"push" data back to the central site.  This has the advantage that the remote machine IP 
address can change without interrupting data collection.  This can be done in addition to 
all of the above methods.  The disadvantage is that you have to dig through log files to 
find out the current IP addresses of the radial site computers.
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Firewalls

If your ISP has a firewall in place, be sure to have them open at least the following ports to the 
SeaSonde computer:

Protocol! ! ! Port
Secure SHell (SSH)!! 22
Timbuktu Pro!! ! 407
Apple Remote Desktop! 3283, 5900
RadialWebServer! ! 8240 (can be changed)

Assembling the Antennas
Inventory and Preparations
If the installation site is remote, a missing part or tool will delay the installation. Ensure that you 
have all the required parts, tools and support equipment before departure. Checklists are 
provided in this guide.
Pack a clean work surface in your field kit. A piece of cardboard, paper, or cloth will work. The 
surface will be placed under threaded antenna parts to keep them clean. In addition, many small 
parts are used to assemble the antenna. The small parts are difficult to find if dropped in grass 
or dirt. A surface under the work area makes it easy to find dropped items.
Include spare fasteners in your field kit, in case any are lost. Spare fasteners must be made of 
the material specified in the checklists. In particular, do not replace stainless steel parts with 
non-stainless steel.

Inspection
Summary procedure:
• Inspect physical condition.
• Perform electrical continuity checks.
A damaged or malfunctioning part will delay installation. The following inspections and tests 
should be performed prior to departure to a remote installation site.
The transmit cable and corresponding connectors on the antenna and transmitter are Type N 
coaxial connectors. Each connector has two conductors, a central pin or socket and an outer 
hollow cylinder. The conductors are enclosed by a threaded metal body.

Type N Connector Plug
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Type N Connector Socket

Inspect the physical condition of all electrical connectors.
▢ Connector bodies should not be bent or damaged.
▢ Connectors should be securely attached to cables.
▢ Connector pins, sockets and outer conductors should not be bent or loose.
▢ Center pins and outer conductors should not extend beyond connector bodies.
▢ Center pin should sit flat with the outer conductor. Should not be recessed in too much(not 

more than 1mm) or extend beyond the outer conductor.

Perform electrical continuity checks with an ohmmeter or multimeter. Remember, zero or low 
resistance indicates continuity, the ability to conduct electricity. Infinite or large resistance 
indicates no continuity. Some meters have a continuity test mode.
Continuity checks for the spooled cable are performed easily while the cable is on the spool.
▢ On the spooled transmit and receive cables, measure continuity between the connector 

center pins at the two ends of the cable. There should be continuity (very low or zero 
resistance).

▢ On the spooled transmit and receive cables, measure continuity between the connector outer 
conductors at the two ends of the cable. There should be continuity.

▢ On the spooled transmit and receive cables, measure the continuity between a connector 
center pin and the outer conductor of the same connector. There should be no continuity 
(very high or infinite resistance). Repeat for the antenna cable connector at the other end of 
the cable.

Transmit Antenna Check (Long Range only)
▢ A lightning arrester with a Type N socket connector is mounted on the spool-shaped ground-

plane feed subassembly, attached to the lower antenna section. Measure the resistance 
between the center socket of the connector and the lightning arrester housing. Be careful. Do 
not bend or damage the center socket when measuring. There should be no continuity.
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▢ There is an exposed metal fitting on the lower antenna section, 0.75 meters above the base. 
Measure the resistance between the center socket of the lightning arrester connector and the 
metal fitting. There should be continuity. (There is an epoxy seal opposite the metal fitting. Be 
careful. Do not remove or damage the seal.)
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Dome Style Combine Antenna Setup

The procedure outlined below is the same for all dome style receive and T/R combined 
antennas.  The photos were taken for a 13 MHz combined antenna and so minor manufacturing 
differences may exist between your antenna and those shown here.  If you have any questions, 
please contact CODAR support. Use the instructional video located on the Support website 
along with the instructions below for the dome antenna set-up.

When assembled and raised, the antenna is approximately 8 meters tall. The antenna consists 
of one antenna element (a fiberglass whip), a dome-shaped base that contains electronics, a 
fiberglass mast, inner mast assembly and Transmit-Receive (TR) cable spool. (see Table and 
Figures below).

Dome Style Combine Antenna Parts

Item #
(refer to 

images below)
Antenna Parts Qty Model Number Ship 

Bundled

1 TR Antenna Assembly 
(Dome-Style)

SSRA-101-13T
R

2 Dome Assembly 1 SSRA-
SA101-13

X

3 Inner Top Mast 1

X

4 Dipole Feed Assembly 1

X
5 Mast Stand (used for 

assembly only)
X

6 Choke Cable 1
X

7 Hand hole cover 1

X

8 Sight Pins

X

9 Assembly Screws

X

10 Spare Screws

X

11 Inner Bottom Mast 1

X
12 RG-316 cable assembly 1

X13 Bottom guide plastic tube 1 X
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Item #
(refer to 

images below)
Antenna Parts Qty Model Number Ship 

Bundled

14  Antenna Whip 1

X

15  Antenna Mast (Dome-style) 1 SSRA-
SA301-13

X

16 TR Antenna Cable (75m) 1 TRCBL-STD X

Items 2, 3 & 4 are shipped pre-assembled. Similarly items 11,12 & 13 are shipped pre-
assembled. These  top and bottom inner masts are connected together and then secured to the 
outer fiberglass mast. 

Lastly, the cable connectors at the base of the mast are attached to the mast strain relief fixture 
and cable connectors are attached. The next few pages describe the assembly procedure in 
detail.

Tools List

• Phillips screwdriver #2 size
• Adjustable wrench with 1 1/2” or 300 mm opening

•  7/16” fixed opening wrench, or 7/16” socket.

• Dow Corning 4 Electrical Insulating Compound
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Procedure
▢ Identify the top and bottom inner mast assemblies. 

▢ A plastic tube with the RG-316 cable assembly is present inside the bottom inner mast as 
shown in the above picture.

▢ Pull out the plastic tube so that you can see the RG-316 cable assembly.

▢ Align the top and bottom inner mast assemblies using the mast stands.
▢ Connect the RG-316 cables to the respective SMA connectors on the dipole feed assembly 

of the inner top mast. Use silicon grease on SMA connectors and the polycarbon coupler 
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portion of the Dipole Feed Assembly where the top and bottom inner masts make a 
connection (Dow Corning 4 Electrical Insulating Compound is recommended). Cables are 
labelled as shown below. Optimal tightening of the SMA connectors is 8 inch-lbs, or ~ 1 N-m. 
This can be done with a torque wrench, or by hand tightening and adding an extra 30 
degrees turn.

▢ Once all the 3 cables are connected, slide the bottom mast over the polycarbon coupler so 
that the two masts are connected. Use 8-32 Phillips head screw with spring washer for feed 
connection (the brass terminals) and 1/4-20 hex screw (as shown in the picture below) for 
mechanical attachment to the polycarbon support. 

▢ This completes the assembly of the inner masts.
▢ Locate the bottom guide plastic tube at the end of the bottom mast. 3 RG-316 cables with 1 

N and 2 TNC bulk-head jack connectors exit through the bottom guide.
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▢ Have bulkhead connectors tacked into the plastic tube to avoid breaking them while sliding 
into the outer mast.

▢ Next, slide the entire inner assembly into the outer fiberglass mast. When the inner assembly 
hits a stop, go to the Hand hole end, reach in to guide the bottom plastic tube through the 
centering rods.

▢ Insert hardware screws in the fiberglass mast collar.
▢ Align dome base with fiberglass mast collar screws. Tighten all collar screws to attach the 

dome base.
▢ Attach antenna whip element to top of the dome. Use silicon grease to attach the whip.
▢ There is a locknut at the base of the threads on top of the dome. Do not remove this lock nut. 

After attaching the whip element, tighten this lock nut counter-clockwise against the metal 
antenna whip fitting. This prevents the whip from unscrewing itself due to wind induced 
vibrations.
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▢ At the base of the fiberglass mast, pull bulkhead connectors down and out through the 
access port.

▢ Find strain relief flap on back interior of mast.
▢ Connect all three bulkhead connectors to cable strain relief. Secure the connectors with the 

nuts provided along with the connectors.

▢ Locate the 22 feet cable bundle with ferrites (13 MHz only). There are 3 cables in this bundle 
with cables for the two loops each and the dipole.

▢ Lay out the cables on the ground. One end of the cables has 2 TNC and 1 N plug 
connectors. The other end has bulkhead connectors. There are ferrites on each end  of each 
cable. Place the ferrites gently on the ground do not drop them. Ferrites can crack or break 
easily which will compromise performance. 
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▢ Feed the plug connectors into the bottom of the fiber glass mast or the side hole. 
▢ Connect 3 connectors with matching cable label or color code.  Apply silicone grease before 

engaging connectors.  The color coding convention is: red - #1, blue - #2, while - #3.
▢ To complete assembly, connect the TR Cable Spool cable TNC & N connectors to connector 

jacks of this cable set. Apply weather resistant tape (shipped with the choke cable) on all 
three connectors.

Antenna sighting method
▢ Dome antenna is shipped with sight pin screws.
▢ These are index markers for sighting the bearing of the black arrow. Two of the fasteners on 

the bottom plate of the Dome antenna, which are parallel to black arrow, are standoffs into 
which the sight pins can be inserted.

▢ In certain sites, it would not be practical for the user to stand back in the direction of the black 
arrow due to landscape limitations.  The user may desire to change the standoff to other 
orientations and make the corresponding changes for the bearing measurement.
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▢ After attaching guy ropes (if required), erect the antenna and secure via permanent antenna 
mount. 

▢ Stand back about 20m from the Dome in alignment with the two sight pins and measure 
bearing to the sight pins using a compass.

▢ This completes your Dome antenna assembly.
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5 MHz (Long Range)

When assembled and raised, the long range transmit antenna is approximately 8.9 meters (29.2 
feet) tall and weighs approximately 45 kilograms (100 pounds). The antenna assembly consists 
of two long sections with a tuning coil connecting them. A “top hat” adapter is mounted at the top 
of the antenna assembly. Eight ground plane wires, 7 meters long, are connected to the base 
and form a circle on the ground.
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Tuning Coil Jumper Strap

The tuning coil is shipped with a metal jumper strap installed. If you plan to transmit at a 
frequency greater than 4.6 MHz, leave the jumper strap installed.  If you plan to transmit at a 
frequency less than or equal to 4.6 MHz, the jumper strap should be removed.

The tuning coil jumper strap is held in place by screws and star washers at its upper and lower 
ends. To remove the jumper strap:
▢ Loosen, but do not remove, the lower screw (nearest the socket end of the tuning coil).
▢ Remove the upper retaining screw (nearest the exterior-threaded end of the tuning coil).
▢ Rotate the strap 180 degrees around the lower screw.
▢ Replace and tighten the upper screw and star washer. Tighten enough so that the screw 

stays in place. Do not over tighten.
▢ Tighten the lower screw enough so the strap does not move. Do not over tighten.

Installation

A crew of at least three strong people is needed to raise the antenna.
Transport all the parts and tools to the installation site.

Installing Cable

Antenna Parts Checklist

Parts marked “not supplied” are not supplied by CODAR and must be procured from other 
sources.
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Note: many parts are pre-assembled. For example, the antenna feed is completely 
assembled and mated to the lower antenna section.

Check Qty Description

UPPER ANTENNA SECTION PARTS

1 transmit antenna, upper section

2 set screw, cup point, 10-32 x 3/8", 3/32" hex socket, stainless 
steel

LOWER ANTENNA SECTION PARTS (The fasteners and 
gasket listed mate the lower antenna section to the antenna 
feed subassembly.)

1 transmit antenna, lower section

4 cap bolt (full thread), 1/2-13 x 2-3/4”, stainless steel

8 flat washer, 1/2”, stainless steel

4 lock washer, 1/2”, stainless steel

4 nut, 1/2-13, stainless steel

1 (optional), teflon gasket (Gasket goes between lower antenna 
section and antenna feed.)

ANTENNA FEED PARTS

1 spool-shaped base, stainless steel

9 ground plane wires, 25 feet long, stainless steel

9 bolt, 1/4-20 x 3/8”, stainless steel (fastens ground plane wire to 
antenna feed)

9 lock washer, 1/4” (on ground plane wire bolt)

9 flat washer, 1/4” (on ground plane wire bolt)

1 antenna feed connector, Type N, attached to base

1 lightning arrester with Type N connector, attached to antenna 
feed connector

TUNING COIL ASSEMBLY PARTS

1 tuning coil
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Check Qty Description

1 tuning coil jumper strap, stainless steel, with black shrink tube 
insulation

2 screw, phillips head, 10-32 x 1/4”, stainless steel

2 internal star washer, #10, stainless steel

2 set screw, cup point, 10-32 x 3/8", 3/32" hex socket, stainless 
steel

TOP HAT ASSEMBLY PARTS

1 top hat adapter, stainless steel sleeve

4 antenna element, 0.062” diameter, 3 feet long, titanium alloy 
(6 AL/4V ELI)

1 retaining washer, 1” outside diameter, with five holes

4 cap screw, 8-32 x 7/16", 9/64" hex socket, stainless steel

4 internal star washer, #8

3 set screw, cup point, 10-32 x 3/16", 3/32" hex socket, stainless 
steel, red marking on threads (inserted in upper holes of top hat 
adapter)

3 set screw, soft point (nylon), 10-32 x 3/16", 3/32" hex socket, 
stainless steel, green tipped (inserted in lower holes of top hat 
adapter)

MOUNTING HARDWARE (not supplied)

4 (not supplied) bolt, 5/8”-11, length as required

4 (not supplied) nut, 5/8”-11

4 (not supplied) lock washer, 5/8”

4 (not supplied) flat washer, 5/8”

4 (optional, not supplied) guy ropes, non-conductive, length as 
required (10 m nominal). For long-term installations, Kevlar with 
UV-resistant outer braid is recommended. To reduce cost, nylon 
can be used for short-term installations.

4 (optional, not supplied) stakes or anchors to tie down guy ropes
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Check Qty Description

1 (for temporary install, not supplied) base, plywood, 1-inch thick 
(minimum), 0.75–1 m diameter or square, holes drilled with 
antenna feed bolt hole pattern

CABLE

1 cable, RG-8 with N-type connectors, 75 m

OPTIONAL EQUIPMENT

1 lightning protection kit, CODAR part LP-100

as
required

(not supplied) non-metallic fencing, markers, and/or signage

as
required

(not supplied) split loom tubing, plastic,1 inch nominal, or 
conduit, (e.g., Schedule 40 PVC), 1 inch nominal, (to protect 
cables from animal damage)

Tool Checklist (Tools not supplied.)

Check Qty Description

1 hex (Allen) driver or key, 3/32"

1 hex (Allen) driver or key, 9/64"

1 strap wrench

as
required

hammer(s) to drive ground plane wire stakes and guy rope 
stakes

1 Ohmmeter or multimeter for continuity checks

1 tape measure or rangefinder

as
required

Moisture-proof insulating silicone lubricant. Dow Corning 4 
Electrical Insulating Compound is recommended.

as
required

clean working surface (cardboard, towel, etc.)

1 (optional) pipe, 1 m long, to put through cable spool
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Summary:
• Locate antenna site.
• Unspool and route cable.
Exercise care when installing the cable. Do not crush the cable or allow it to kink. (Minimum 
bending radius is 4 inches.) Do not exert excessive pulling tension on the cable. (Maximum 
pulling tension is 230 pounds.) Do not pull on the connectors. Do not damage the connectors.
▢ Find the desired transmit antenna location. Pace off the distance or measure with a 

rangefinder or tape. Ensure that the cable length is adequate for the distance between the 
SeaSonde electronics and antenna.

▢ Start at the SeaSonde electronics and ensure the transmit cable can be mated to the 
transmitter (or optional LP-100 lightning protection kit, if installed) and is properly routed.

▢ Unspool the transmit cable from the antenna site to the SeaSonde electronics. Insert a 1 
meter pipe through the spool and have two people walk the pipe and spool to the electronics. 
Excess cable should be stored near the electronics, not near the antenna.

▢ Double-check the routing and ensure there is enough slack to mate the connectors at each 
end.

▢ If needed, install split loom tubing or other protection around the cable to avoid damage by 
animals.

Assembling Top Hat Adapter

The top hat adapter is so named because it fits over the top of the antenna. It consists of a metal 
sleeve and four stiff wire elements. The wire elements are held in place by a washer-like retainer 
and four fasteners. The top hat adapter is secured to the antenna with set screws.
Summary:
• Flag the sharp ends of the wire elements with tape for safety.
• Loosen retaining washer screws.
• Insert wire elements.
• Tighten retaining washer screws.

Injury warning: the wire elements may cause injury to eyes or other parts of the body. Mark the 
end of each wire, so that it is seen easily. Safety glasses are recommended.

▢ Place a piece of adhesive tape on one end of each wire, so that it is seen easily.
▢ Using a 9/64 inch hex (Allen) driver or key, loosen the four cap screws that hold the retaining 

washer in place at the end of the top hat adapter. Loosen just enough to slip the wire 
elements snugly between the retaining washer and one of the grooves in the top hat adapter.

▢ Insert a wire element between the retaining washer and a groove in the top hat adapter. 
Repeat for all four wire elements.

▢ Tighten the four cap screws on the top hat adapter.
▢ Set the top hat adapter aside. It will be installed on the antenna a few steps later.
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Assembling Antenna

Summary:
• Arrange antenna sections.
• Lubricate with non-conductive silicone grease (Dow Corning DC-4 or equivalent) and screw 

upper antenna sections and tuning coil together. Tighten set screws.
• Lubricate and screw together lower antenna section and tuning coil. Tighten set screws.
• Install guy rope collar and guy ropes if used.
• Install top hat adapter.
▢ Lay out the two antenna sections on the ground and arranged end-to-end for assembly. The 

tuning coil is installed between the lower and upper antenna sections. Ensure that the 
connecting parts remain clean by placing a clean surface (cardboard, paper, a towel or rag, 
etc.) under them.

▢ Ensure that the tuning coil jumper strap is in the correct position. It should be installed 
(secured with both screws) when transmitting greater than 4.6 MHz. It should be uninstalled 
(removed from the upper screw) when transmitting less than or equal to 4.6 MHz. If the 
tuning coil jumper strap must be uninstalled, follow the instructions earlier in this guide.

▢ Coat the socket threads at the bottom of the upper antenna section with a moisture-proof 
insulating lubricant. Dow Corning DC-4 Electrical Insulating Compound is recommended.

▢ Coat the threads at the upper section of the tuning coil (Dow Corning DC-4 or equivalent 
works well).

▢ Screw the tuning coil tightly onto the upper antenna section.
▢ Tighten the two set screws at the bottom of the upper antenna section using a 3/32 inch hex 

(Allen) driver or key.
▢ Coat the socket threads of the tuning coil with moisture-proof (e.g. Dow Corning DC-4).
▢ Coat the threads at the top of the lower antenna section with moisture-proof insulating 

lubricant.
▢ Screw the tuning coil with upper antenna section tightly onto the lower antenna section. Use 

a strap wrench if necessary.
▢ Tighten the two set screws at the bottom of the tuning coil using a 3/32 inch hex (Allen) driver 

or key.
▢ Wrap the metal sections of the tuning coil with electrical tape or self fusing tape for added 

protection.
▢ (Optional.) If using guy ropes, slip the top of the antenna through the center hole of the guy 

rope collar. The eye bolts on the guy rope collar should point downward, i.e., the eyes should 
be closest to the ground when the antenna is raised. Slide the collar to the center of the 
antenna until it stops in place at the metal fitting of the upper antenna section.
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▢ (Optional.) If using guy ropes, attach four non-conductive guy ropes to the four guy-rope-
collar eye-bolts.

▢ Begin installing the top hat adapter by placing it over the top of the upper antenna section. 
Ensure that the top of the antenna is completely inserted in the top hat adapter.

▢ Tighten the three upper top hat adapter set screws (cup point with red marking) using a 3/32-
inch hex (Allen) driver or key. These metal-tipped screws should make firm contact with the 
metal tip of the antenna whip.

▢ Tighten the three lower top hat adapter set screws (soft point, green-tipped) using a 3/32-
inch hex (Allen) driver or key. These nylon-tipped screws are designed to make contact with 
the fiberglass whip just below its metal tip. Do not overtighten.

▢ Remove the adhesive tape markers from the top hat adapter wire elements.

Raising and Securing Antenna

Summary:
• Orient antenna.
• Raise antenna.
• Place antenna on support and tighten fasteners.
• Secure guy ropes if used.
• Release and arrange ground plane wires. Stake if needed.
• Mark keep-out area if needed.
• Take up cable slack.

▢ There are nine evenly spaced ground-plane wires connected to the ground-plane feed 
assembly in a 360 degree arc and secured to the feed with bolts.

▢ If needed, attach a temporary base to the ground plane feed assembly base.
▢ Hold the antenna base in position while others lift the antenna at its middle (near the tuning 

coil) and raise the antenna by walking it toward the base.
▢ If using a permanent support, lift the antenna and place the ground plane feed assembly over 

the support bolts. Install and tighten support nuts. A hinged baseplate adapter is highly 
recommended as a safety measure and ease of antenna maintenance in the future.

▢ If using guy ropes, secure them while one or more people hold the antenna in place.
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▢ The ground plane wires are wrapped around and secured to the ground plane feed 
assembly. Remove the material that secures the ground plane wires.

▢ Unwrap the ground plane wires from the ground plane feed assembly.
▢ Arrange the ground plane wires so that they are evenly spaced 360 degree around the 

antenna base.
▢ If needed, secure the ends of the ground plane wires with long nails or irrigation hose stakes 

to keep them in their proper orientation. Metal stakes can be used.
▢ If needed, mark or secure the area with non-metallic fence, markers and/or signage to keep 

people from tripping over the ground plane wires or touching the antenna.
▢ Take up any cable slack at the antenna by looping the cable into a 0.3 meter diameter coil at 

base of antenna.
▢ Connect the transmit cable to the lightning arrester at the base of the antenna.
▢ Connect the transmit cable to the transmitter connector or the optional LP-100 lightning 

protection kit.
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Drawings
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Antenna Feed
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Protection Kit

The SeaSonde Lightning Protection Kit (product code LT-E1) is an optional accessory that is 
compatible with all SeaSonde models.  It consists of an all-weather industrial enclosure 
containing an array of spark gap arrestors and 30’ (9 m) coaxial extension cables (three RG-58 
& one RG-8).  See photos below.

This kit is intended to be installed inline between the SeaSonde electronics and the Rx/Tx 
antenna(s).  It provides no protection for the antennas, only for the electronics chassis.  The 

SeaSonde SSRS-100 Operator’s Manual

33



enclosure should be mounted upright and, preferably, outside of the room/enclosure containing 
the electronics chassis.  Four 1/4” diameter holes are available for mounting screws.
Installation
• Pass the transmit and receive cables from the antennas through the open cable-hole of the 

lightning protection kit enclosure.
• Connect the transmit (or T/R) RG-8 cable to the N connector of the spark gap arrestor labelled 

TX ANT.  Similarly, connect the receive antenna RG-58 cables to the arrestors marked 
channels 1-3.  You will connect only cables 1 & 2 to the arrestors if you are using a T/R 
antenna.

• Close and secure the box.
• Connect the coaxial extension cables of the Lightning Protection Kit to the respective channels 

on the back of the transmit and receive chassis channels.
• IMPORTANT: Grounding the enclosure.

• There is a small terminal on the outer side of the enclosure to the left of the cable hole as 
shown below. Connect a heavy duty gauge#8 copper wire or strap (not included) to this 
terminal and connect the other end to a proper electrical ground.

• Proper electrical ground can be a metal stake driven into the soil or an existing ground 
system for a local building/structure.

• Consult a local electrician if you have questions about the proper length of ground stake for 
local soil conditions.

Ground terminal on 
underside of enclosure
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Configuring the SeaSonde
This configuration section is for brand new systems that have been pre-configured at CODAR. 
To pre-configure you own computer and load the SeaSonde software see the computer set-up 
manual that corresponds to you r operating system.

Confirm electronics rack cable connections

Confirm that following cable connections are made.
▢ TRANSMIT DRIVE OUT (receiver) ↔ TRANSMIT DRIVE IN (transmitter)

▢ TRANSMIT CONTROL (receiver) ↔ TRANSMIT CONTROL (transmitter)

▢ ANTENNA 1 LOOP 1 (receiver) ↔ Loop 1 (receive antenna)

▢ ANTENNA 2 LOOP 2 (receiver) ↔ Loop 2 (receive antenna)

▢ TRANSMIT OUT TO ANTENNA (transmitter) ↔ transmit antenna

▢ GPS to GPS antenna
For separated transmit and receive antennas:
▢  ANTENNA 3 MONOPOLE (receiver) ↔ Monopole (receive antenna)

For combined transmit and receive antenna:
▢ RECEIVER ANTENNA 3 (OPTIONAL) (transmitter) ↔ ANTENNA 3 MONOPOLE 

(receiver)

Initial Power Up
▢ Confirm the transmitter is switched off and unplugged.
▢ Connect the computer to the receiver with the supplied USB cable
▢ Plug in the computer and press the power button.
▢ After computer starts up, quit all applications.
▢ Plug in and switch on the receiver.
▢ Click the SeaSondeController icon in the Dock or in SeaSonde/Apps/RadialTools.
▢ Choose Receiver Controller > Select Port… menu item. 
▢ Confirm SeaSonde Receiver is displayed in the pop-up menu. If not, choose SeaSonde 

Receiver from the pop-up menu.
▢ Click OK.
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Configure Site Information

Computer Name

▢ Select a descriptive four-character code for your site (characters A-Z, a-z, 0-9)
▢ Change the computer name in System Preferences-> Sharing by adding your site code using 

the format SeaSondeSite-XXXX (where XXXX is your four-character code)

       

▢ Delete any existing RadialConfigs folders found in /Codar/SeaSonde/Configs

SeaSonde SSRS-100 Operator’s Manual

36



Site Parameters 

▢ Launch the SeaSondeRadialSetup program. Located in the Dock on the Desktop or in 
SeaSonde/Apps/RadialTools.

▢ Select the type of system (Long/Standard/High Res) you are operating.

Site Parameters in SeaSondeRadialSetup:
▢ Enter your four-character site name in the “Site Code” box
! Optional: add a site description in ”Description” box.
▢ Select your preferred timezone. Your data files will be referenced to and labeled with the 

selected timezone. CODAR suggests using UTC. The timezone should match the timezone 
selected in System Preferences -> Date & Time.

▢ Enter the WGS-84 latitude and longitude of the receive antenna separated by a comma in 
the “Location” box. Make sure the N/S and E/W are correct. CODAR uses the Garmin 
handheld GPS to obtain this location point.
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Transmit parameters:
▢ Enter your licensed operating frequency in MHz. Use the center frequency of your authorized 

bandwidth.
▢ Check mark the “Max Bandwidth” box and type in the maximum bandwidth you are allowed 

for your licensed frequency.
Antenna parameters: 
▢ Enter the magnetic compass bearing of the black arrow of the two nylon index markers.

Note: Phase corrections and the measured antenna pattern file will be installed later.

▢ Click the “Save” button at the bottom of the GUI.
Configure Receiver Settings in SeaSondeController
▢ Choose Receiver Controller > Advanced Control.... The Advanced Receiver Controller dialog 

appears.
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▢ Set Attenuation to 20 and press the “Atten” button next to the value field.

▢ Choose Receiver Controller > Transmit Drive Control

▢ Uncheck the check marked Transmit Drive Trips so that the Transmit Drive Control window 
looks like the pic below. This is to make sure that the Transmit does not get tripped off during 
startup. You will be resetting the Transmit Drive Trips later in the configuration.
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▢ Press Store in the Receiver Advanced Controller window to save these settings before you 
start up the transmitter.

Powering up the transmitter

▢ Confirm that the transmitter power switch is off.
▢ Plug in the transmitter power cord. 
▢ Click the SeaSondeController icon in the Dock.
▢ Receiver Controller > Transmit Monitor…. The RC1 Transmit Monitor window appears.

▢ In the Advanced Receiver Controller window, attenuation (Atten) should be set to 20 dB and 
settings should be stored.
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▢ Switch on the transmitter. The question marks under the Forward portion and Reflected 
portion of the window should turn from question marks as in the picture above, to  values 
similar to the picture below.

Confirm that the values in theTransmit Monitor are as follows:
▢ Reflected (power) is less than 25% of Forward (power).
▢ VSWR is 3 or less. VSWR is the ratio next to the reflected power measurement.
▢ Identify and correct problems if VSWR is greater than 3.
Repeat the following steps until Forward (power) in the RC1 Transmit Monitor window is 40-50 
watts and VSWR is less than 3.
▢ Reduce Atten from 20 to 10 and press the Atten button. If VSWR is less than 3 continue.
▢ Reduce by 1 the entry in the Atten field of the Receiver Controller window. For example, 

enter “9” if the current value is “10”.
▢ Click the Atten button.
▢ Forward power should be around 40 - 50 watts, VSWR should be 3 or less.

Configure GPS synchronization (SHARES systems only)

▢ Confirm the GPS antenna has a clear view of the sky.
▢ Confirm the GPS antenna cable connects the GPS antenna to the receiver.
▢ Click the SeaSondeController icon in the Dock to make it active.
▢ Choose Receiver Controller > GPS Monitor…. 
! The RC1 GPS Monitor dialog appears:
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▢ Confirm that at least four satellites are shown by the Satellites indicators.
▢ Observe the Survey progress bar . Wait until Survey is complete.
▢ Store the SeaSonde’s position:

• Confirm the Position Stored indicator is green. If it is not, follow below steps.
• Select the checkbox next to the pop-up menu labelled Get Versions.
• Choose Store Survey GPS Position from the pop-up menu.
• Click the Go button. The SeaSonde’s position is stored.
• Repeat this step if the position is not stored.

▢ Confirm all indicators are green.
▢  Go to the open Transmit Drive Control window and recheck all of the Transmit Drive Trips as 

shown in the Window below; Until First Status Check, When Rcvr Temperature Exceeds 40, 
When GPS Not Ready, and When PLL Unlocked should all be checked.

▢ Store these settings in the Receiver Advanced Controller window:
• Click Store to store settings as switch-on defaults. The settings are stored in receiver 

memory location 1.
• Enter “SAVE 2” in the Send field.
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• Click Send to store settings in receiver memory location 2. This is a backup.
▢ Capture an image of the Advanced Receiver Control dialog:

• Press Command-Shift-4.
• Press the Space bar. The pointer changes to a camera.
• Click the Advanced Receiver Control dialog.

Note: An image of the dialog named “Screen Shot #” (where # is a time stamp) is saved to 
the Desktop. Rename it to something like “ControllerSettings.”

▢ Click the SeaSondeAcquisition icon in the Dock and look for Bragg peaks in the Spectra 
window. Note that shape of Bragg peaks will change from site to site. A typical Spectra with 
Bragg peaks for a long range system is shown below.

▢ Confirm that Bragg peaks are present in A3 (Monopole - Channel 3) Spectra Map
▢ Select “Monitors” menu->Cross Spectra Power Map->Antenna 3
▢ Confirm that Bragg peaks are present in A2 (Loop 2 - Channel 2) Spectra Map
▢ Select “Monitors” menu->Cross Spectra Power Map->Antenna 2
▢ Confirm that Bragg peaks are present in A2 (Loop 1 - Channel 1) Spectra Map
▢ Select “Monitors” menu->Cross Spectra Power Map->Antenna 1

Computer reboot test

▢ Choose Apple menu > System Preferences…. The System Preferences window appears.
▢ Click the Users & Groups icon. The Users & Groups pane appears.
▢ Click the SeaSonde user’s icon. (The user is normally “codar”.)
▢ Click the Login Items tab.
▢ Confirm Sentinel is listed in “These items will open automatically when you login:”.
▢ If Sentinel is not listed, add it to the list:

• Click the “+” button.
• Select /Codar/SeaSonde/Apps/RadialTools/Sentinel
• Click the Add button.
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▢ Choose Apple menu > Restart…. The “Are you sure you want to restart your computer now?” 
dialog appears.

▢ Click Restart.
▢ After the computer starts up, confirm that Sentinel launched the processing suite. 
▢ Confirm that data are being acquired in SeaSonde Acquisition’s  Spectra Map window. 
▢ Re-visit the site in 6 or more hours and confirm that CSQ, CSS, RDLi radials are being 

created and stored in their respective folders in /Codar/SeaSonde/Data/Spectra/... and /
Codar/SeaSonde/Data/Radials/IdealPattern/

••The SeaSonde remote unit is configured and operating••
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Measuring the Antenna Pattern
This section describes how to perform a SeaSonde antenna pattern measurement (APM). The 
SeaSonde uses an APM to calibrate the antenna response vs bearing for local, site-specific 
conditions resulting in increased accuracy and reliability of the data outputs.
It is necessary to do a dry run / walking APM before hiring a boat. Follow the steps below 
within a day to a week before doing the actual boat pattern. This ensures that all of your 
equipment is working and you can actually get the transponder peak located for the 
APM ! ! ! ! ! ! During this dry run we recommend following the below steps for an APM and 
trying to collect the land points that are described at the end of this section.

Items Required
▢ Transponder (SSTR-101) including:
▢ Transponder charger
▢ Custom USB data cable
▢ Whips

▢ SeaSonde Remote Unit (SSRS-100) including:
▢ Antenna(s), cables, Rx chassis, Tx chassis and computer

▢ GPS navigator capable of storing time-stamped track. Garmin GPS 60, GPSMAP® 60 or 
GPSMAP® 76 product lines are recommended.

▢ Transponder Extender Kit (SSTR-EX) if operating frequency < 20 MHz, including:
▢ four piece green whip antenna
▢ whip antenna feed/base
▢ grounding cable
▢ custom transmit cable

▢ Voice communications (2 x two-way radios, cell phones, etc.)
▢ Boat
Whip Configurations Required

SeaSonde Model Antenna Configuration
(Boat Run-APM)

**Antenna Configuration
(Walking-WAPM)

          5MHz 12MHz head w/green antenna + OCEAN 
GND

three 8’ white whips on sides and 
top

        12MHz 12MHz head w/green antenna + OCEAN 
GND

three 8’ white whips on sides and 
top

        25MHz White whips (2 - 4’ whips on sides + 8’ on 
top)

two 4’  white whips on sides and 8’ 
top

        42MHz White whips (2 - 4’ whips on sides + 4’ on 
top)

three 4’ White whips on sides and 
top
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Charging the transponder battery (done at least one 
day before the APM)

▢ Open the transponder case. Inside, there is a printed 
circuit board with a socket labeled CHARGER and a 
power switch.

▢ Plug the transponder charger into an electrical outlet.
▢ Plug the transponder charger’s round plug into the 

CHARGER socket on the printed circuit board. The 
FAST CHARGE indicator on the charger will light red 
while the battery charges.

▢ When the FAST CHARGE indicator light turns off, the 
battery is charged. Keep the battery fully charged to 
lengthen battery life.

▢ Unplug the round plug from the CHARGER socket.
Configuring the transponder
▢ Plug the USB data cable into the USB data port on 

the side of the transponder case.
▢ Plug the standard USB connector of the data cable 

into any available port on the SeaSonde computer, or 
laptop with R7U1 or later.

▢ Switch on the transponder.
▢ On the computer, open SeaSondeTransponder app located in SeaSonde/Apps/RadialTools. 

The Transponder Controller window will appear. If the transponder is being recognized there 
will be green lettering saying, “Transponder Connected.”
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▢ If the transponder is plugged into the site computer, you simply press the Initialize button in 
the Transponder Controller window. This will set the transponder center frequency to match 
the site and set the appropriate Offset for that frequency. Press Store when done.

▢ If the transponder is plugged into a computer other than the site computer. You can press 
Initialize in the Transponder Controller window, enter the desired center frequency (which is 
your SeaSonde operating frequency) and press the Frequency button. The offset will be 
entered in automatically. Press Store when done. 

▢ The center frequencies and corresponding offsets for transponder configuration are listed 
below.

▢ Switch off the transponder.
▢ Quit SeaSondeTransponder app.
▢ Switch on the transponder.
▢ Launch SeaSondeTransponder app.
▢ Confirm the transponder settings are the same as what you stored.
▢ Switch off the transponder.
▢ Unplug the USB data cable connector from the transponder.
The transponder is set up for an APM.
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▢ Place the transponder at least 1 wavelength away from the SeaSonde receive antenna.
▢ Use the whip configurations in the table at the beginning of this section for walking APM.
▢ Turn the transponder on.
Configure the Receiver and  Locate the Transponder Peak
▢ Quit all applications except SeaSondeController and SeaSondeAcquisition.
▢ Click the SeaSondeController icon in the Dock.
▢ Choose Receiver Controller > Advanced Control.... The Advanced Receiver Controller dialog 

appears, take a screenshot of your original operating settings if one does not already exist on 
the desktop (shift + command +4).

▢ Choose Receiver Controller > Receiver APM Configuration. When prompted by the dialogue 
box press OK. The proper settings should be entered into the Advanced Controller window 
automatically. The values can be checked to the look up table below.

SeaSonde
Model

Bandwidth Blanking Bdly
µs

Attenuation
Boat/Walking

Sweep 
Frequency

Pulse
Shaping

5MHz 25kHz  60* ~4.75 15/30db** 2Hz Off
12MHz 50kHz 60 ~4.75 15/30db** 4Hz Off
25Mhz 150kHz 60 ~4.75 15/30db** 8Hz Off
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42MHz 150kHz 60 ~4.75 15/30db** 8Hz Off

▢ At the SeaSonde computer, click the SeaSondeAcquisition icon in the Dock.
▢ Choose Processing > Enable Loop Diagnostics. Two windows appear, The Loop Diagnostics 

window and the SpectraRangeDisplay window.
▢ In SeaSondeAcquisition go to Monitors > Range Display menu item.
▢ Confirm that the transponder signal peak appears in the Range Display window. 

▢ Note. RangeDisplay is usually the easiest way to locate the transponder peak, and determine 
approximately what Range cell it is in. You see what range cell the peak is in on the X-axis of 
the RangeDisplay. The Transponder peak in the picture above is in approximately range cell 
11. However, occasionally the peak can not be seen in this window.

▢ After the initial set of sweeps, confirm that the transponder signal peak appears in the 
SpectraRangeDisplay.
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▢ The APM settings should put the transponder peak around range cell 11. To define the peak 
to the range cell where it is strongest, use the Loop Diagnostics window. Change the range 
cells in the Search For Peaks section. Start out with the range cells wide open, in the pic 
below the software will be looking for the transponder peak between range cells 5 to 15. At 
the top of the SpectraRangeDisplay the Range Cell with the strongest peak is reported, in the 
example above is it range cell 11. Fine tune the Loop Diagnostics Range Cells so that the 
transponder peak is isolated between 1 or 2 range cells.

▢ Set Doppler cells search limit from 6 to -6 to search for transponder peak between these 
doppler cells. 

! (Note: It should be 6 to -6 as shown in the picture and not -6 to 6). Reason for ! this is 
we want to avoid searching near the DC region(Doppler cell 0) where ! you can pick up 
bragg peaks instead of transponder peak. You can always ! adjust the range cell and doppler 
cell search region depending on where the ! transponder peak is actually located during your 
APM.
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▢ Once the peak is located. Turn the transponder off and watch the peak go away in the 
SpectraRangeDisplay window.

▢ Turn the transponder back on and make sure that the peak you have determined as the 
transponder peak returns in the SpectraRangeDisplay.

▢ Shut off the transponder and get in position for the boat or walking APM.

Set up the transponder antenna on the boat
Transponder on a boat (SeaSondes operating below 20 MHz)
▢ Assemble and mount to the boat the four-piece whip antenna and feed included with 

Transponder Extender Kit (SSTR-EX).
▢ Attach the transmit signal cable type N connector to the antenna feed, the white wire to the 

Monopole Transponder Antenna Port and the black wire to one of the grounding antenna 
ports.
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▢ Ground the antenna feed or one of the transponder grounding antenna ports to the seawater 
connecting the 20’ grounding wire to seawater
• directly over the side of the boat with end of wire weighted to stay in water or
• via a seawater ground point on the boat or propellor motor.

Transponder on a boat (SeaSondes operating above 20 MHz)
▢ Attach an eight-foot fiberglass whip antenna element in the Monopole Transponder Antenna 

Port on top of the yellow transponder case.
▢ Attach an eight-foot fiberglass whip antenna to BOTH of the grounding antenna ports on the 

front and back of the transponder case.
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Transponder carried on land 
Attach an eight-foot fiberglass whip antenna element in 
the Monopole Transponder Antenna Port on top of the 
yellow transponder case. Attach eight-foot fiberglass 
whip antennas to BOTH of the grounding antenna ports 
on the front and back of the transponder case. See table 
for the whip configuration that is suggested for your 
operating frequency.

Set up tracking on your GPS handheld
▢ Set up your GPS navigator to log a track.
▢ Record track entries by time increment: 1 to 5 seconds for a boat APM, depending on 

memory available in your GPS. Always use 1 second intervals for walking antenna pattern. At 
least one GPS measurement (called an epoch) needs to be made in each angular bin of the 
coverage arc.

▢ Synchronize the SeaSonde computer clock with the GPS navigator clock by going to 
SeaSonde Controller then Receiver Controller > GPS Monitor and comparing it to the time on 
the GPS device being used for the APM
Note: Track files downloaded from the GPS unit must contain a date and time stamp for 
every position recorded.  Garmin models only save this information in the ACTIVE track log

Set up the SeaSonde to Log Data
▢ Click the SeaSondeAcquisition icon in the Dock to select SeaSondeAcquisition.
▢ Choose File > Log Cross Spectra to deselect Cross Spectra logging.
▢ Confirm there is no check mark next to the File > Log Cross Spectra menu item, indicating 

the item is deselected.
▢ Choose File > Log Time Series. Confirm that Time Series are being created in the 

SeaSonde/Data/TimeSeries folder.
Measure Antenna Pattern
▢ For a pattern from a boat transport the transponder to a test point directly in front of the 

antenna (~300m - 500m from shore) before moving to the starting point of the first arc.  Turn 
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the transponder on and make sure the peak shows up in the SpectraRangeDisplay. Turn it off 
when confirmed.

▢ Move the transponder to the starting point. For walking pattern it should be at least a 
wavelength away. If performing a boat pattern try to be at least 500 m to 1.5 km away close 
enough to shore to maintain a strong signal while traversing the two arcs.

▢ Switch on the transponder.
▢ Confirm that the transponder peak appears in the SeaSondeAcquisition’s 

SpectraRangeDisplay window as described above. The transponder signal peak may be 
hidden from view if it is around a land feature on a boat.

▢ Confirm that Time Series are being created.
▢ Start track logging on the GPS navigator.
▢ Move the transponder (on a boat or by walking) in a circular arc centered on the receive 

antenna. Maintain a constant speed no more than 4 knots.  Walk slower than you think you 
should. The transponder signal peak should remain in the same location in the 
SpectraRangeDisplay window.  If the ship is traveling too fast the peak will shift to the edge 
of the display and will serve as a warning to slow down.

▢ For boat, at the end of arc 1, reverse course and retrace the arc in the opposite direction. Try 
to get the the boat as close to shore as safely possible at the end of each arc. 

▢ For walking, if possible make two complete circles around the receive antenna. Keep the 
antenna at least a wavelength away. Make one circle, at the end of the first circle, walk a 
circle in the other direction. This is best case scenario, if a complete circle is not possible get 
as close to a complete circle with your arcs.

▢ After completing two full arcs in opposite directions, uncheck File > Log Time Series in 
SeaSondeAcquisition to end logging.

▢ The person with the GPS should turn it off.
APM is complete.
Store APM data
Copy or move the following data to a separate folder. The data will be used to generate an 
antenna pattern file for use with your SeaSonde remote unit.
▢ The directory /Codar/SeaSonde/Data/TimeSeries, including the files in that folder.
▢ The directory /Codar/SeaSonde/Configs/RadialConfigs, including the files in that folder.
▢ The GPS navigator track log file.
Land Points
Note: Land points may not always be possible due to geographic limitations. Perform 
land points only if it is safe to do so.
▢ Using the GPS points at the end of both sides of the arc taken during the main APM, plot a 

straight line from the SeaSonde antenna and a point on the land that would connect the point 
where the ship would have touched the coast and the antenna.  
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▢ Create an APM land point by placing the transponder at the point described above following 
the APM procedure for each land point individually.  At the end of the process you will have 
the main APM data set of TimeSeries (Lvl files) and GPS track files and two short segments 
of time with land point TimeSeries fils and their GPS track files. Measure the SeaSonde 
antenna position with the GPS immediately after collecting land points. This position 
information will be used as a reference when merging the land points and APM arcs together.

▢ Send this information to CODAR Ocean Sensors for consolidation into a single file set. Usual 
charges will apply.

Store APM data
Copy or move the following data to a separate folder. The data will be used to generate an 
antenna pattern file for use with your SeaSonde remote unit.
▢ The directory /Codar/SeaSonde/Data/TimeSeries, including the files in that folder.
▢ The directory /Codar/SeaSonde/Configs/RadialConfigs, including the files in that folder.
▢ The GPS navigator track log file.
Re-Configure SeaSonde for normal operation
▢ Click the SeaSondeController icon in the Dock.
▢ Choose Receiver Controller > Restore Hardware State. Press Load, Receiver settings should 

be back to normal operation.
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Making an Antenna Pattern File
▢ The GPS and SeaSonde data collected during the APM needs to be processed into an 

antenna pattern file before it can be used to make measured pattern (calibrated) radial 
vectors. This can be done by CODAR (fees may apply) or by someone trained in antenna 
pattern data processing. Refer to SeaSonde Radial Suite Application Guide for 
CrossLoopPatterner and CODAR training materials for more information.

Routine Monitoring

via RadialWebServer Display
The SeaSonde’s RadialWebServer provides you with a means to remotely monitor its 
performance via a web browser.  This application is installed with SeaSonde Radial Suite 
Release 6 and Release 7. Remote monitoring is limited to viewing and downloading the siteʼs 
status, configuration, spectra, diagnostic, wave, and radial data.
A browser client  will need the site's URL or IP address and RadialWebServer user name and 
password to gain access.

▢ To gain remote web browser access the site must be configured with a static IP or a DNS 
service to allow the site to be visible on the Internet.

▢ You also need to specify the port number to use. The default Codar port is set to 8240. Using 
the default port is recommended. [Note:Please read the RadialWebserver-Admin.pdf 
document included with the Release 6 and Release 7 installer, before you customize with a 
non-default port number. 

▢ To access the remote site, enter the site’s static IP address or the DNS URL and the port 
number. Example: http://x.x.x.x:8240, where x.x.x.x is the site’s static IP address. 

▢ Test the RadialWebServer on the site. Open Safari and enter "http://localhost:8240" (use 
your selected port number, if not 8240)

▢ The login page shown below is displayed when accessed using Safari. 
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▢ Enter the RadialWebServer Admin user name and password. A successful login will result in 
showing the status of the site. Don't be concerned about the alerts, yet, if you are still setting 
up your site.

Click on the Admin link in the upper right corner of the window. This  will allow you to view and 
enter more user accounts to access the site. Click on the New user to add more accounts. If you 
want CODAR support staff to be able to access your site, create an account for them.
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▢ User name and password are case sensitive.
▢ Three kinds of authorizations can be set up for a user: 
▢ Site Management: administrative user who has permission to add/remove/edit users.
▢ View Data: user who can see Status, Details, Radials, Waves, Spectra, Diags, Logs, and 

Refresh Settings. This user cannot view or edit the other users and will not see the Admin 
link.
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▢ View Status: user limited to Status, Details, and Refresh Settings. Clicking the other 
views will jump to the login view. This user also cannot view or edit the other users and 
will not see the Admin link.

Note: You will be unable to remove the first Admin user. If you try,you will see a “Cannot 
delete admin user.” message. You can remove all users by reinstalling the RadialWebServer; 
the installer has an option to rebuild the user account database and will create a new first 
admin user as explained in the beginning.  

The above steps should be enough to set up the Radial Web Server 
▢ If there are any problems with the RadialWebServer, use a text editor or Console to open the 

log files RadialWebError.log and RadialWebStatus.log located in /Codar/SeaSonde/Logs/ 
These are included in SeaSondeReports file which should be sent to support@codar.com.

▢ For any additional information about RadialWebServer, please read the RadialWebServer 
Admin document.

Navigating the RadialWebServer interface
▢ Open your browser and enter “x.x.x.x:port’ where x.x.x.x is the static ip address of the site 

and :port is the port number used to install the RadialWebServer (the default is :8240). If 
using at the Remote Unit computer, you can enter “http://localhost:port” to open the 
RadialWebServer page. 

▢ Login Page will appear as in the image below. 

▢ Enter the username and password. 
▢ If login details are correct, the Status View page will open. 
▢ The 4 letter site code is displayed next to the SeaSonde Remote Unit banner. 
▢ On the right are Admin and Sign Out links. Below these 2 links, the date and time at the site 

are displayed. Vertical menu list of views is on the left.
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The different views are as follows:
Status!! :Siteʼs current status
Details! :More detailed status about the siteʼs configuration, status, hardware, and 
! !  data.
Radials! :Plot any radial within last year on the site.
Waves! :Plot any wave data within last year on the site.
Spectra! :Plot any spectra within last year on the site.
Diags! ! :Plot the hardware and radial diagnostic files.
Logs! ! :View critical site logs and create/download a SeaSondeReport file
Archives! :Download archived data from the site

Settings! :Change the refresh interval and setup the alert email service.

Status view gives a quick look of whether the site is working well or not. 
▢ Alerts section lists any problems with the site. IF no problems exist, then “Nothing to 

Report” message is shown. 
▢ “Site XXXX” section shows basic information about the site like name, location and other 

settings. Clicking on the co-ordinates opens a google map of the site’s location in a new 
window. 
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▢ The Radials section shows thumbnails of the last radial vectors for both Measured and 
Ideal patterns plus a 25hr averaged radial for the site. Clicking on the thumbnail will open 
a full size pot. 

▢ The Spectra section shows the last CSS and CSQ cross spectra power maps. Clicking on 
the thumbnail will open a full size plot.  Carefully look at the radials and spectra plots can 
tell you how well the site is operating. 

The Details View shows sections with detailed information about the Site, Alerts, 
Receiver,Transmitter, Data Files, Processor, and SeaSonde Applications running. Some of the 
useful information here is receiver firmware, hardware temperature, transmit power, disk space 
available, and applications’ version numbers.
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The Radials View allows you to plot and download radials up to one year ago on the site.
▢ The first section allows selection of the radials to plot and/or download.
▢ The months during which the radial data is available, are highlighted with blue and an 

underline. Click on the blue text to select the month. 
▢ This will display the corresponding month’s calendar below the selection. 
▢ The days with at least one radial file are highlighted in blue with an underline.
▢ To the right of the calendar is the Control Time bar with hours and minutes pop-up menus. 

Select the hour and  minute to display the corresponding radial. 
▢ Use the Step arrows to step back or forward in time to plot each existing radial. 
▢ Click on “Measured” or “Ideal” links in the Type bar to display corresponding radials. If the 

selected type does not exist, you will get a “No Matching Radials” instead of a plot below.
▢ The Latest: Auto Off control, if set to Auto, will automatically show the latest radial.
▢ The section below this is the Radial Plot section,which displays the radial image

plot. You can drag and drop this image to the desktop or Right Click and select 
“Save As” to save the image. 

▢ Download section is at the bottom. It shows the link to download the selected radial. 

SeaSonde SSRS-100 Operator’s Manual

62



▢ The small white triangles next to the section titles “Radials” and “Radial 
RDLm_2009_03_29_0600”. if clicked on will collapse the section so that it is hidden.

The Waves View can plot wave data up to one year ago on the site.
▢ Select the start time to plot using the calendar as in the Radial view. 
▢ Time Span pop-up menu allows to set the time span of the plot. 
▢ The Latest control when set to auto will periodically refresh the page with the latest wave 

data. 
▢ The Wave plot section contains eight plots. Four plots for range cell 3 of wave height, 

wave period, wave direction, and wind direction followed by four plots each containing 
range cells 2, 3, 4 & 5 of wave height, wave period, wave direction, and wind direction.

▢ The Download section shows one or two waves files for the current time. Since Wave files 
are monthly, the current month and the previous month both might be shown here. 
Clicking on the link will download the selected wave file.
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The Spectra View can plot spectra data up to one year ago on the site.
▢ Selects the spectra time to plot in the Cross Spectra section. 
▢ Select CSS or CSQ in the Type control to switch between the averaged CSS spectra and 

the more raw CSQ spectra.
▢ The first plot is the power map which shows the power returned as color intensity across 

all doppler and range cells for the three cross loop antennas.
▢ The second plot section is a single range slice of power versus doppler. Use the slider 

and arrow control to select the range cell to look at.
▢ The download section allows to download a reduced cross spectra file. is a special 

variation of the standard cross spectra files which is compressed about 3:1. The utility 
SpectraShortener can expand this file to a standard cross spectra format.
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The Diags View can plot the diagnostics history of the hardware and radial status diagnostic 
logs.
▢ Use the Control section to set the start time and the time span to plot.
▢ Next is a radial diagnostic section containing 10 different plots followed by a hardware 

section containing 7 plots.
▢ The Download section shows one to four diagnostics files for the current time.
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▢ The Logs View shows a list of system and SeaSonde logs for the site and also allows the 
web user to enter notes into a site log and generate /download a SeaSonde Report file.
▢ Enter any notes, logs in the Site Log Entry section and click the Submit button.
▢ This entry will be time stamped and tagged with your RadialWebServer name and 

appended to the Site_XXXX.log file where XXXX is the site code.
▢ Click on any log file in the Log Files section to view the log file in the next section.
▢ The Diagnostic Report section allows you to generate and download a SeaSonde Report 

file which you can send to CODAR support personnel for diagnosing problems. 
Customers are recommended to send this file to CODAR support whenever contacting for 
any issue. 

▢ Click the Generate button to start downloading a RPT_XXXX_yyyymmdd_hhmm_web.zip  
file. The file size can vary between 2MB
to 5MB, hence can take couple of minutes to download
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The Settings View is used to control settings for the RadialWebServer and the email alerts. The 
“System Settings” section will only be available to admin users.
▢ Currently, the only configurable setting available is the Web Page Refresh Interval. This 

time sets how often the browser requests new data from the site. 
▢ The refresh setting applies to the Status, Detail and any other views using Latest: Auto 

mode.
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Setting up Email Alerts

The Settings View in the RadialWebServer interface allows to set up email alerts.
▢ RadialSiteReporter tool on the remote unit computer generates the site alerts and 

optionally emails them.
▢ Read RadialSiteReporter document for detailed information on its function. 
▢ Click on Alert Mail Configuration link to enter the email address to whom the email alerts 

should be mailed. (This feature is available only to admin user account).

▢ Click on the Create New link to add the email address to the list. Remove link will delete 
the email address from the list. Edit link will enable editing the settings for the particular 
email address in the list. 

▢ Enter one or more email addresses separated by comma. 
Note: Please, do not abuse this feature; do NOT send alert emails to an unsolicited address.
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▢ Select the Enabled checkbox to activate that email address(es) to receive alerts.
▢ Select the Send Alert Changes checkbox to send an email to addresses whenever an 

alert is tripped or cleared. 
▢ Select the Send Periodic Report checkbox to send out the Site info plus the Alert logs 

periodically selected by the Schedule: popup. (Currently, this feature is not available.)

Below is an example of the email alert:

From: codar@SeaSondeSite-XXXX.local
Date: March 30, 2009 12:14:24 AM PDT
Subject: [SeaSonde] TEST Alerts [TxNotFound,CSSNoBragg,CSQNoBragg]
To: you@yourisp.com
2009-03-26 13:14 UTC-7 Failure: Transmitter Not Found.
2009-03-26 13:14 UTC-7 Failure: CSS has No Bragg.
2009-03-26 13:14 UTC-7 Failure: CSQ has No Bragg.
2009-03-26 13:14 UTC-7 Failure: Radial Contains No Vectors.
2009-03-27 18:53 UTC-7 Failure: Radial is Not Up-to-Date.
2009-03-30 00:14 UTC-7 Success: Computer is Running
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via Timbuktu Pro (Screen Sharing)
Timbuktu Pro is a screen sharing and data transfer application for PC and Macintosh computers.  
It is installed by default on computers shipped with SeaSondes or spare units ordered from 
CODAR.  It is a valuable tool for viewing real time data displays on remote SeaSonde 
computers.

Controlling the Screen of the Remote Unit Computer

Locate the Timbuktu Pro menu found in the upper right hand portion of the Desktop menu bar 
(Macintosh) or on the widget tray (Windows) and select the Open Timbuktu Pro menu item, this 
will open/activate the Timbuktu Pro program. 

Go to the File menu on the left side of the menu bar and select the New Connection menu item:
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In the New Connection window, select the Internet tab bar item as shown below and enter the 
IP address of the SeaSonde Remote Unit computer.

Next, click on the Service menu bar item.  Select the Control from the drop down menu:
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A Control Session Login Panel will appear:

Select either the Registered User or Registered User (Secure), enter in the Name and Password 
of the account and click OK.

Note: Consult SeaSonde Support if you do not know account login information

The Remote Screen Control window should appear.  This will allow you to interact with the 
computer over the internet as if you were physically in front of the computer screen:
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Transferring Data to/from the Remote Unit computer

In order to transfer files, an Exchange Session must be activated.  Click on the Service Menu at 
the top of the Desktop.  Select the Exchange Menu Item.

This will bring up a Exchange Session Login Dialog.

Select either the Registered User or Registered User (Secure) account login and enter in the 
Name and Password associated with the account.  Consult SeaSonde Support if you do not 
know the account login information.
The Exchange Session window will appear.  This will allow to transfer files and folders to and 
from the remote site computer.
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The Exchange Session window has two main areas: the file space of the Remote Site Computer 
and the Local Computer.  These areas can be used to navigate both remote and local file 
systems.

The following example will demonstrate how to navigate to and move a file from the Remote Site 
Computer to the Local Computer.  First, navigate to the target folder on the Local Computer (left 
side) by clicking on folder or volume icons appearing in the Local Computer File Space to move 
down the folder tree or by using the drop down menu for the current folder to move up the folder 
tree:

Next, navigate to the source folder in the Remote Site Computer (right side) and select a file to 
be transferred.  The file will highlight in blue:
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Click Copy.  A File Transfer Panel will appear with a progress bar.

The transferred file will appear on the Local File Space when the transfer is complete:
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Viewing Vector Data with SeaDisplay

SeaDisplay is CODAR’s surface current data visualization tool.  It can be used to plot radial and 
combined surface currents as well as generate radial distributions, plot standard deviations and 
generate current vector animations.

Opening SeaDisplay
Click on the SeaDisplay Icon 
found in the Dock. Or 
SeaSonde/Apps/Viewers.

A map window showing the 
default map area should 
appear.

The task bar, located located 
above the map area on the 
left side, contains icons that 
control the most important 
functions. .

The velocity color scale is 
show along the right side of 
the map window.
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Task Bar IconsTask Bar Icons

File Open

Display a File Open dialog and point to the Radial Files folder.  
When a file is selected, SeaDisplay will automatically load all 
matching radial files in the same folder.

   
Prev       Next

Plot the previous or next sequential radial file in the same 
folder.

Radial Distribution

This is the Radial Distribution Plot Icon.  Clicking on this icon 
will allow the user to see the radial density plots of the radials 
in the Radial Files folder.

Save Image

Create a PNG image file of the current window display.

Create Movie

Create a Quicktime movie of all the radial data files contained 
in the current folder.  The movie file will be written to the 
Desktop of the user's Macintosh computer.

Setup

Open the SeaDisplaySetup program to modify the current 
SeaDisplay site map. Please refer to Creating Site Map found 
in Optional Configuration Tasks.

Spectra Plotter Map

Opens the Spectra Plotter Map application.

Plotting Radial Files
Click on File Open and select 
a radial file from the Choose a 
File dialog. Dragging a file 
and dropping onto the 
SDisplay icon will also open a 
file. Double-clicking a file will 
also open in SDisplay.
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The selected file will be 
plotted and all matching files 
will be loaded into memory.

By clicking Prev or Next the 
user can step through 
sequential radial files one at a 
time.

To create a radial distribution, 
click Radial Distribution in the 
task bar.

This may take a little time, 
depending on the size of the 
radial file list.

When the computation is 
complete, a radial distribution 
plot will be displayed on the 
map.

Note: the velocity scale on the 
right is now replaced with a 
Vector density scale.
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Viewing Spectra
Spectra Plotter Map is a visualization tool that allows for the plotting of spectra data.  This 
software also allows for analysis of signal to noise ratio, signal noise floors, maximum 
amplitudes and phases with regards to physical range and doppler range.
Plotting Cross Spectra Files
There are three primary types of spectra files that Spectra Plotter Map can plot and analyze:
CSQ files - These files are created after the first FFT process and are considered the lowest 
level cross spectra files
CSS files - These are merged sets of CSQ files that are created by the CSPro program.  These 
are the files that are used by the radial processing tools to extract radial vector files.
CSA files - These files are averages of CSS file sets over an hour.
This document will cover opening and analyzing a CSS file using Spectra Plotter Map.  The 
other file types a can be similarly opened and used in the same fashion.  
To open a CSS file mouse to the folder containing Spectra data.  Normally the user can find the 
CSS files either in the following folders:
/Codar/SeaSonde/Data/Spectra/SpectraProcessed/
/Codar/SeaSonde/Data/Spectra/SpectraToProcess/
or alternatively in the Archives folder:
/Codar/SeaSonde/Archives/Spectra/

Spectra Processed Folder

Simply drag and drop a CSS file onto the SpectraPlotterMap Icon on the Dock found in the 
Desktop.
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The SpectraPlotterMap program opens with four main dialogs; the SpectraColorMap, the Range 
Slice Map, the Doppler Slice and the CSS Informational Display dialog.  A brief description of 
these main dialog follows:

Spectra Color Map

This dialog displays signal intensity via a color "temperature" display, cooler colors indicate lower 
signal or noise levels while warmer colors indicate greater intensities.  Normally the dialog 
shows the signal and noise levels on all three antenna channels as indicated on the left hand 
side of the dialog.  The horizontal axes are normally displayed as  Doppler cells  from the center 
or DC region of the graph going out in positive and negative Doppler directions and physical 
range cells distances for the vertical axes.  These axes can be changed to translate the distular 
range and Doppler cell range to frequency and kilometer units ( or other combinations) by 
mousing to the Graph menu and checking the options desired.
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Graph Menu

Range Slice Dialog

The Range Slice Map Dialog displays the signal strength of an individual range cell.  This is in 
contrast to the the spectra color map that shows signal simultaneously for all range cells and 
frequency shift. Note the three antenna channels are displayed on this dialog are biased to be 
20 dB apart with regards to each channel so that the spectra can be seen clearer rather then 
displaying the three channels directly on top of each other.  The horizontal and vertical axes of 
this dialog will change along with the Spectra Color Map by changing options in the Graph Menu 
detailed above.
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Doppler Slice Plot

The Doppler slice map shows the signal power in terms of decibel per meter  for each doppler 
cell with regards to range.  This dialog with change as the focus is moved along the Range Slice 
Map Dialog or the Spectra Map via the arrow keys on the keyboard.

Focus Indicator on the Range Slice Map
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Cross Spectra MetaData

The Informational Dialog displays relevant spectral information for a specific range and Doppler 
bin.  As the focus indicator is played around in range and doppler cells the dialog entries will 
change.  Center frequency, bandwidth, FFT length and other transmit information normally found 
in SeaSonde Controller setting will also be recorded in blue text.

Viewing Diagnostics

This section describes how to use DiagDisplay to perform routine monitoring of radial data 
collection and SeaSonde hardware operation.  It is a valuable tool for troubleshooting of most 
problems.

About DiagDisplay

DiagDisplay is an application that is used to plot different SeaSonde radial and hardware data 
parameters from the diagnostic files, on a graphical display to evaluate/diagnose the radial data 
and the SeaSonde hardware operation. The diagnostic files (with the names beginning with 
“STAT_”) are located in  /Codar/SeaSonde/Data/Diagnostics. Two types of diagnostic files are 
produced weekly on Sundays with the name STAT_XXXX_YYYY_MM_DD.EXT, where XXXX is 
four character site code and “.EXT” is the extension of the file. “.EXT” is .rdt for radial diagnostic 
files and .hdt for hardware diagnostic files. DiagDisplay can be used to plot several weeks or 
months of diagnostic files at a time.
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Opening Diagnostic Files

The DiagDisplay application is located in /Codar/SeaSonde/Data/Apps/Viewers.  It can also be 
found in the Dock on a factory-installed SeaSonde computer.

DiagDisplay Icon

You can monitor different parameters like Radial range, Radial vector count, Noise Floors, Signal 
To Noise Ratio, temperatures inside the SeaSonde Transmitter and Receiver chassis, some 
common voltages of the equipments, and so on, using DiagDisplay. 
It is a good practice to plot the diagnostic files (“STAT_”) weekly or bi-weekly to check the 
different radial and hardware parameters. 
▢ Click the DiagDisplay icon on the Dock. 
▢ The Adjuster Dialog and the Diagnostic History Plot window will open. 

Diagnostic History Plot and the Adjuster Dialog

▢ Choose File > Open. Drag and drop method or double-click will also open a file.
▢ Select the “STAT_” diagnostic files and click on the “Open” button to open files.
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File Menu Open

▢ By default it will plot one of the sets of parameters of the Diagnostic Files on the Diagnostic 
History Plot. 

Diagnostic Files plotted on the Graph

▢ Quick Plots pane in the Adjuster Dialog is used for quick plotting of a default set of related 
parameters simultaneously, like Noise Floors, Signal to Noise Ratios, Phases,etc.

▢ Select “Custom” checkbox to plot parameters from different sets together. 
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Custom Plots

Maintenance Check and Troubleshooting

The example below shows how you can use DiagDisplay for maintenance check of normal 
operation of radial data collection and SeaSonde hardware operation. This example specifically 
covers an instance, when a client observed a sudden reduction in radial range during their 
regular maintenance check. This example shows how DiagDisplay can be used in such cases to 
try to find out the suspected reason of problem. There can be more than one reason leading to 
the same problem. This example covers one of the many reasons leading to the same problem. 
▢ Select the “Range” checkbox to plot the Radial Max Range, Radial Vector Count and Radial 

Average Velocity simultaneously. 

Plotting Radial Range Parameters

▢ Depending on your site’s operating frequency and settings, confirm if the radial max range 
and the radial vector count seem reasonable. 
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▢ Verify if there is any period of time, when the range and/or vector count decreases.
▢ Select different set of parameters from the Quick Plots section to plot on the graph and 

confirm if everything is working reasonably well. 

Sudden reduction in Range

▢ The Radial Vector Count and Radial Max Range looked reasonable till Wednesday 11/19. 
The radial range and vector count suddenly dropped to zero on 11/19. 

▢ So, you can plot other parameters to find out the cause of range reduction.
▢ Select “Tx Power” checkbox. This will plot Transmitter Forward power, Reflected power and 

the Transmit Trip parameters.
▢ Make sure that your site’s forward/reflected power readings are reasonable depending on 

your settings.!

Power Plot

▢ The plot shows that the forward power was reasonable till Wed. 19 and then suddenly drops 
to zero. 
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▢ This shows that the Transmitter is not transmitting any output power. It can be due to several 
reasons like tripped transmitter, fallen antenna, cable cut, bad transmit power supply, bad 
transmit amplifier or any other non-working module in the Transmit or Receive chassis. 
▢ Since, there is no forward power, there is no radial coverage.  
▢ The “Transmit Watch Trip” graph shows that the transmitter was not tripped at the time 

of failure. The default value is “0”, the value rises to more than 1 when the TX gets 
tripped. So in this case, there is some other reason. 

▢ Plot other parameters to try to find the reason for no forward power. 
▢ Select “Noise Floors” checkbox. Check the noise floors on all three channels. 

Rise in Noise Floors

The noise floors suddenly increased around Wed 19. This can be due to several reasons like 
sudden increase in the environmental noise or some internal hardware failure or due to bad 
antenna.  
▢ Select “Signal To Noise” checkbox. Check the signal-to-noise ratios on all three channels. 
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Drop in Signal-to-Noise Ratios

The Signal-to-Noise Ratios on all the three channels dropped to almost zero, as there was no 
output power after Wed 19.
▢ Select “Temperatures” checkbox. Make sure that all the temperatures look reasonable. 

Temperatures Plot

The transmitter chassis temperature was reasonable till Wed 19, but after that it went very high. 
This can be either due to the very high surrounding atmospheric temperature or very high 
temperature generated inside the chassis due to some hardware component failure. 

Transmitter Chassis Temperature Rise

You can plot TX and RX voltages to confirm, if the common voltage readings inside the chassis 
are correct.
▢ Select “RX voltages” checkbox. 
▢ Confirm, if the Receiver +5V and +12V readings are correct. (Receiver DC supply reading is 

only for systems with DC supply).
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▢ If both the +5V or +12V supply reading are correct, it means there is most likely no 
failure in RX chassis components.  

▢ If any of the supply readings is in-correct, then it means there is a  hardware failure of 
one or more components inside the RX chassis.

RX voltage readings

▢ Select “TX voltage” checkbox. 

TX Voltage Reading
▢ On  Wed. 11/19, the TX power fell to zero, TX chassis temperature rose to a very high value 

and the Transmitter Amplifier supply dropped from its normal 24/28V value to a lower value.
▢ Un-check the “View” checkboxes with Transmitter Chassis and Transmitter Forward fields.
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Transmit Amplifier Supply Drop
▢ This means that there may be some problem with the Transmitter amplifier power supply. 

▢ Hence client was suggested to make a site visit and measure the Transmitter power 
supply voltage and few other voltage readings in the TX chassis. 

▢ Finally, after all measurements, it was clear that there was some problem with the amplifier 
which was pulling down the Supply voltage.

▢ In this way, you can use DiagDisplay, to get an idea about the suspected reason for any 
failure in hardware operation or irregular collection of radial data. 
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Data Management

This section describes how to confirm that the Archivalist application is functioning properly and 
how to correct some common problems. The document also provides examples of common 
Archivalist configuration changes and guidelines for data archive maintenance. Note that 
Archivalist is not a backup utility and it is up to the SeaSonde user to periodically copy your 
important data and configuration files to a more permanent storage. 

About Archivalist

Archivalist is a utility application for maintaining output folders that build up with
lots of data files.  Archivalist will create archived copies of the files while maintaining a limited 
number of source and archived folders/files (limiting means it will delete older data as 
configured.) The SeaSonde Radials Site produces many different types of output files time 
stamped at various intervals.  Archivalist organizes copies of the data files into /Codar/Archives/ 
and keeps the data folders from filling up with too many files in order to prevent the hard disk 
from filling up. The default limits for a Radial Site are meant for typical hard disks with room left 
over for future data like bistatic and other add-ons. If your hard disk, is less than 80GB you will 
want to reduce these limits. If you hard disk is much larger, you might want to increase these 
limits to hold more data on site.

Archivalist can also copy data to an external drive which can be used to transport data offsite; 
see Copy an archive to an external disk below.

Check Archivalist function and configuration

▢ Look at the Archivalist icon in the Dock. Confirm that there is an application-open indicator 
below the icon.

▢ Click the Archivalist icon in the Dock to open Archivalist or make it active.
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Check settings

▢ Choose Control > Change Archives…. The Archive Control dialog appears.

▢ Review the checkboxes in the Archives pane and confirm that the expected archives are 
selected.

▢ Click each archive name in the Archives pane and review its settings in the other panes. 
Confirm that the settings are correct.

▢ After the settings are confirmed observe the Sources and Archives data amounts and confirm 
that data is being stored.

Check archives

In the Finder, confirm that files are correctly archived. Archives are normally in /Codar/
SeaSonde/Archives.
▢ Confirm that archives are located in the folders specified by the Archivalist settings.
▢ Confirm recent archiving by checking file-created dates for recent dates and times.
Confirm the archive sizes for each archive folder:
▢ Select an archive folder.
▢ Choose File > Get Info. An Info window appears.
▢ In the Info window’s General pane, confirm that the number of archived files or archive 

sizes are the same as the settings.
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The Archive Control settings may be empty. If the settings are empty, see Restore Archive 
Settings.

Check status and disk usage

▢ In Archivalist, choose Window > Show Status Window. The Status window appears.
▢ Review the Status window entries for any red-colored error messages. If there are any 

errors, correct them.
▢ Click the CodarData disk on the desktop.
▢ Choose File > Get Info in the Finder. The CodarData Info window appears.
▢ In the Info window’s General pane, confirm that the available disk space is at least 

5 Gigabytes (GB) or 10% of the disk’s capacity, whichever is less.
If the available disk space is less than 5 GB or 10% of the disk’s capacity,
▢ change the Archivalist settings to reduce the archive size (see Archive Configuration 

Examples)
or

▢ delete the oldest archive files (after backing them up, if desired).
If an extra copy is made to a separate disk,
▢ check the disk’s available space.

If the disk is nearing its capacity,
▢ delete the oldest files on the disk

or
▢ exchange the disk for a disk with more available space.

▢ If you encounter problems that you can not solve, open /Codar/SeaSonde/Apps/Scripts/
SeaSondeReportsHigh. A report file /Codar/SeaSonde/Logs/
RPT_XXXX_YYYYMMDD_HHMMSS_hi.zip is created. Email the report to 
support@codar.com with an explanation of the problem and your attempts to solve it.

Restore empty archive settings

Use the following procedure if you discover that the Archive Control settings are empty. That is, 
all the checkboxes in Archive Control dialog’s Archives pane are deselected and all the archive 
names are blank.
▢ Quit Archivalist
▢ In Codar > SeaSonde > Configs > RadialConfigs delete the file Archivalist.plist
▢ On the Dock click the Archivalist Icon to restart Archivalist.  The program will automatically 

generate a new default property list with standard archive settings.
▢ In Archivalist go to Control > Edit Archives
▢ Confirm the settings are correct.
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Archive Configuration Examples

The following examples demonstrate how to make some common configuration changes. Refer 
to the SeaSonde Radial Suite Application Guide for Archivalist for complete details on archive 
configuration.

Reduce archive limits to increase available disk space

You may discover that your archive configuration does not leave enough available disk space. In 
this example, you decide to reduce the number of ideal-pattern radials data files that are 
archived.
▢ Some of the archives will be deleted when the limits are reduced. If you want to back up the 

current archives, do it before reducing the limits.
▢ Choose Control > Edit Archives…. The Archive Control dialog appears.
▢ Click Radials LLUV Ideal in the Archives pane.

Note that 168 files are duplicated in the source folder.  These are seven days of data. (168 files / 
1 file per hour / 24 hours per day = 7 days) You decide to reduce the duplicated files in the 
source folder to three days of data. 3 days * 1 file per hour * 24 hours per day = 72 files.
▢ Enter 72 in the “duplicated file(s) in source folder” field of the Source pane.
Note that 104 weekly archives are duplicated to the destination folder. (“Limit 104 weekly 
folder(s) in destination” in the Destination pane.) These are two years of data. (104 folders / 1 
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folder per week / 52 weeks per year = 2 years) You decide to reduce the duplicated files in the 
destination folder to 1 year of data. 1 year * 1 folder per week * 52 weeks per year = 52 folders.
▢ Enter 52 in the “Limit … weekly folder(s) in destination” field of the Destination pane.
▢ Click the Save button. The changed configuration is saved.
▢ Click the Run Now button. If the previous archive sizes exceed the new settings, the archive 

sizes are reduced to the sizes of the new settings.
▢ Archivalist automatically organizes archived folders by using a token replacement system as 

shown below.

 Note how the ‘XXXX’ token is replaced by the site four letter code.

Copy an archive to an external disk

In order to archive to an external drive proceed with the following.
▢ Connect the external FireWire disk drive to the SeaSonde computer.
▢ In the Finder, rename the external disk “CodarArchives”.
The normal settings backup all selected archives to the CodarArchives disk. To review the 
settings or change which files are backed up.  A second drive can be simultaneously be 
connected to the computer under the name “CodarArchives2”.
▢ In Archivalist, choose Control > Edit Archives…. The Archive Control dialog appears.
▢ Click an archive button in the Archives pane.
▢ Deselect the “Also, backup the archives to” checkbox and/or the “if above fails, then try” 

checkbox for any archive items that are not to be save to the connected external drives.  
Archivalist is by default set to archive all active archive items to the “CodarArvchives” and 
“CodarArchives2” drives if they exist.

▢ Click the Save button if you change a setting.
▢ Repeat for each data archive.
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CODAR Support Services
SeaSonde Training and Self-Help Resources

Training Courses

CODAR offers 3-day basic training courses at its Mountain View, CA Headquarters twice per 
year. One free basic course tuition is included with each SeaSonde purchased.  Contact 
support@codar.com for course information and reservations. Course dates and descriptions are 
posted on our website http://www.codar.com.  Onsite training can also be purchased.

CODAR highly recommends that operators of SeaSondes HF radar systems attend a basic 
training session prior to equipment installation.

SeaSonde Support Website

CODAR Technical Support hosts a support website at support.seasonde.com.  The login and 
password for the T.I.P.S. page (Technicians Information Pages for SeaSondes ) is provided to all 
new SeaSonde owners at the time of purchase.  The TIPS pages are updated with the latest 
software bug fixes, answers to commonly asked questions and tutorial video screencasts for 
explaining how to perform the most common tasks.

HF Radar Library

A comprehensive “pdf library” of peer-reviewed publications pertaining to oceanographic 
applications for HF Radar can be found at http://www.codar.com/bib.htm. Most of the articles are 
full-text documents and can be downloaded as pdfs.

How to Get Technical Support

If you require technical assistance and have a support service contract on file with us, please 
feel free to email support@codar.com or call +1 408 773 8240 and ask the operator to speak 
with a member of our Technical Support staff. There is no charge for short answers (~ 5 minutes 
or less) but at a minimum, we do require that a CSERV-A support services contract be setup in 
advance.

The Principal Investigator/Owner of the SeaSonde(s) and his/her authorized technicians are 
identified in the contract forms along with correspondence and billing addresses.

Setting up a Support Services Account

To set up a Pay-As-You-Go (CSERV-A) service contract or to purchase pre-paid Time-Bundle 
(CSERV-B),  please complete the appropriate form and email it to support@codar.com or fax it 
to the attention of Technical Support Services at +1 408 773 0514. Forms are also available on 
the support.seasonde.com website and in the Appendices at the end of this document.
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CODAR also offers more comprehensive service plans that include pro-active service checks 
and maintenance by our staff.  Annual site visits can also be provided if required. Please contact 
support@codar.com for custom pricing for our CSERV-C and CSERV-D plans.

No-Charge Services

CODAR will not charge for time spent diagnosing software bugs or for doing the requisite 
diagnostic checks provided that an RMA is issued and the equipment is returned to CODAR for 
repair.

If the software or hardware problem/complaint turns out to be a user configuration error or is a 
result of improper operation, then we will invoice the user for the Technical Support consultation 
on an hourly scale.

If an RMA is issued as a result of a remote diagnosis made by a CODAR technical support staff 
member and the hardware is not returned for repair within 30 days, we will also invoice for time 
spent diagnosing the problem.

Reporting Problems to CODAR

Identifying a problem

Prior to contacting CODAR’s Technical Support Services department please prepare a detailed 
description of the problem and collect and email the latest SeaSondeReports log (if applicable). 
We will also need the serial numbers of the equipment and the remote contact information for 
the sites (IP addresses and any custom passwords).

If your SeaSondes are running CODAR SeaSonde Release6 or later software with 
RadialWebServer, please provide the URL and password for RadialWebServer access.

One-click Diagnostics Using SeaSondeReports

The best way to report information about your remote unit’s status to CODAR Support is to run 
one of the SeaSondeReports scripts available on SeaSonde sites with Release 5 or higher 
installed.  When run, the scripts create a zipped file containing a bundle of system logs, 
SeaSonde data and diagnostics files.

via the RadialWebServer Display

Go to the Logs section of the RWS page and click the Generate button.
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via the Desktop

The SeaSondeReports scripts are found in the /Codar/SeaSonde/Apps/Scripts/ folder.  There 
are two scripts: SeaSondeReportsHigh and SeaSondeReportsMedium.  The primary difference 
between them is the amount of data bundled.  To keep the zipped bundle under most email file 
size restrictions, run SeaSondeReportsMedium.  On computers set up by CODAR, it can also be 
run from the Dock by clicking the following icon:

SeaSondeReports Icon

When run, SeaSondeReportsMedium will create a zipped file of bundled system logs, SeaSonde 
data and diagnostics on the Desktop approximately 10 MB in size with the following name 
format:

RPT_XXXX_YYYYMMDD_hhmmss_md.zip

This file should be emailed to support@codar.com and please include any additional description 
of the circumstances surrounding the issue and/or recent site configuration changes that might 
help us in our analysis.  If immediate assistance or a prompt response is required, our standard 
support policy and rates apply, but submission of the zipped report files is always free and all 
submissions will be reviewed.
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Returning Equipment to CODAR

Procedure
CODAR personnel must authorize any return of materials or hardware for repair, upgrade or 
exchange.  Complete the following steps to avoid delays and additional charges:
▢ Confirm with a CODAR support engineer that your equipment needs to be returned 
▢ Provide the following information to request RMA number. 

• Serial number(s) of the equipment/modules/parts. 
• Describe the problem/type of failure.
• If any troubleshooting steps were already carried out and results of the tests.
• Return shipping address for the equipment.
• Billing address for the RMA fee. 
• Any corresponding diagnostic files or SeaSonde Report file that may help the CODAR 

support and testing teams to troubleshoot your problem.      !
▢ Send above information to CODAR by one of the following methods:

• email: support@codar.com (preferred method)
• fax: 408-773-0514. Attention to Technical Support department
• voice: 408-773-8240; a Technical Support Representative will assist you.
• mail: 1914 Plymouth St., Mountain View, CA 94043

▢ A CODAR Support Engineer will issue an RMA number for the authorized return.
▢ Pack the equipment/materials and clearly label the package with the RMA number.
▢ Ship the materials to CODAR in a sturdy packing to avoid damage in transit.
CODAR will notify the customer’s contact personnel that materials were received.
CODAR will notify the contact person about analyses performed, recommended repairs, price 
estimates, etc.

Notes:
1. Materials out of warranty will be assessed an analysis and repair fee.
2. Dirty or corroded materials may be assessed a cleaning fee.
3. Direct the inquiries about the status of any RMA to rma@codar.com.
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Appendices
A. Dome Combine Antenna Mounting Template

SeaSonde Receive and T/R Antenna Anchoring
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Appendix B:

Box Style Receive & Combined T/R Antenna
Note: the SeaSonde receive antennas and combined transmit/receive antennas are 
mechanically similar and identically assembled. These instructions are applicable to either 
type of antenna.

Box Style Receive Antenna

When assembled and raised, the antenna is approximately 7 
meters tall. The antenna consists of five antenna elements, 
made of fiberglass whips, a base that contains electronics, a 
two-piece mast and cables. The cables are routed through 
the hollow aluminum tubing of the mast. The two mast pieces 
are mated with a plastic coupler. The cables are connected 
to the base. The base is connected to the mast. The antenna 
elements are attached to the base.
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Parts List

Qty Description

1 cable set, 100 meters

1 mast, lower section

1 mast, upper section

1 mast coupler

2 screw, hexagonal head (cap bolt), 4-20 x 3/8 inch

1 antenna box

2 screw, hexagonal head (cap bolt), 4-20 x 3/8 inch

1 fiberglass whip, vertical element (see table below for lengths)

4 fiberglass whip, horizontal element (see table below for lengths)

Fiberglass Whip Lengths

SeaSonde Frequency Vertical Fiberglass Whip 
Length

Horizontal Fiberglass 
Whip Length

4.3 - 5.4 MHz 8 ft 8 ft

11.5 - 14.0 MHz 8 ft 8 ft

24.0 - 27.0 MHz 8 ft 4 ft

40.0 - 44.0 MHz 64 in 30 in

Tools List

• wrench, 7/16 inch (socket with short extender recommended)
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Procedure

▢ One at a time, insert the end of each cable in the large hole at the upper end of the lower 
mast section.  Be sure to start with the largest connector first.

▢ With all connectors inserted, gently push the cables until they appear at the upper end of the 
mast section.

▢ One at a time, insert the end of each cable in one end of the mast coupler and push it 
through the coupler until it appears at the other end. Be sure to start with the largest 
connector first.

 
▢ With all cables threaded through the coupler, insert the coupler in the upper end of the lower 

mast section.
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▢ Align the threaded hole in the coupler with the hole in the mast. Insert a 1/4-20 x 3/8 
hexagonal-head screw (cap bolt) through the hole in the mast and screw it into the coupler. 
Gently tighten the screw with a wrench. Do not over tighten. The threads in the coupler are 
easily stripped.

 
▢ Insert the cable ends and coupler in the lower end of the upper mast section.
▢ Align the threaded hole in the coupler with the hole in the upper mast section. Insert a 1/4-20 

x 3/8 hexagonal-head screw (cap bolt) through the hole in the mast and screw it into the 
coupler. Gently tighten the screw with a wrench. Do not over tighten. The threads in the 
coupler are easily stripped.

 
▢ Gently push the cables toward the top of the mast until they appear at the top.
▢ Remove the four bolts that fasten the black mounting sleeve to the antenna box.

▢ Thread the cables through the mounting sleeve and connect the cables to the antenna box. 
Refer to the diagram on the antenna box and match the cable labels with the corresponding 
base connectors. Finger tighten the connectors. Do not use a wrench or pliers.
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▢ Reattach the black mounting sleeve with its four bolts. Tighten securely with a wrench.

 
▢ Mount the antenna box to the mast. Make sure the mast is fully seated in the mounting 

sleeve.
▢ There are two bolts that secure the antenna box to the mast through threaded holes in the 

black mounting sleeve. Tighten the two bolts securely with a wrench.
▢ The antenna has five fiberglass-whip elements. The elements are screwed into threaded 

holes in the antenna box. One element is oriented vertically, screwed into the top of the base. 
The remaining four are horizontal, screwed into holes at each corner of the base. The lengths 
of the elements vary, depending on the SeaSonde frequency.
Some older SeaSonde models have two-piece antenna elements. The two-piece elements 
are used with 4.3 - 5.4 MHz (Long Range) and 11.5 - 14.0 MHz (Standard Range) 
SeaSondes.

Coat the metal couplers with a moisture-proof lubricant. Dow Corning 4 Electrical Insulating 
Compound is recommended. Push the two pieces together, ensuring they are firmly and 
completely mated. Wipe off any excess lubricant. Wrap the exposed metal coupler where the 
two pieces mate in electrical tape.

▢ Find the vertical element and coat its metal male threads with a moisture-proof insulating 
lubricant. Dow Corning 4 Electrical Insulating Compound is recommended.
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▢ Insert the vertical antenna element in the threaded hole on the top of the base and screw it 
in. Tighten securely using a wrench.

 
▢ Coat the metal male threads of a horizontal antenna element with a moisture-proof insulating 

lubricant. Insert the antenna element in a threaded hole on side of the base and screw it in.
Note: The fine threads are easily cross threaded and can damage the Helicoil insert. Thread 
the whips by hand first, then tighten with a wrench.

▢ Tighten securely using a wrench. Repeat for the remaining three elements, installing at each 
corner of the base.

The SeaSonde receive or combined transmit/receive antenna is assembled.
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Transmit Antenna Assembly

12 MHz and Above

The transmit antenna consists of a two-piece mast, a feed, fiberglass whips and a cable. The 
cable is routed through the hollow aluminum tubing of the mast. The two mast pieces are mated 
with a plastic coupler. The cable is connected to the antenna feed. The feed is connected to the 
mast and vertical and horizontal fiberglass whip elements are attached. When assembled and 
raised, the antenna is approximately 7 meters (24-27 MHz SeaSondes) or 9 meters tall (11.5-14 
MHz SeaSondes).
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Parts List

Qty Description

1 cable, RG-8, 75 meters

1 mast, lower section

1 mast, upper section

1 mast coupler

2 screw, hexagonal head (cap bolt), 4-20 x 3/8 inch

1 antenna feed

2 screw, hexagonal head (cap bolt), 4-20 x 3/8 inch

1 fiberglass whip assembly, vertical element, four mating sections for 
11.5-14.0 MHz SeaSondes or two sections for 24-27 MHz

2 fiberglass whip, horizontal element, 8 feet long

Tools List

• wrench, 7/16 inch
• moisture-proof insulating lubricant. Dow Corning 4 Electrical Insulating Compound is 

recommended.

Procedure

▢ Insert the end of the transmit cable into the large hole at the upper end of the lower mast 
section.
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▢ Gently push the cable until it appears at the upper end of the mast section.

▢ Insert the cable into one end of the mast coupler.

▢ Gently push the cable through the coupler until it appears at the other end.
▢ Coat the lower end of the coupler with moisture-proof insulating lubricant.
▢ With the cable threaded through the coupler, insert the coupler into the upper end of the 

lower mast section.
▢ Align the threaded hole in the coupler with the hole in the mast. Insert a 1/4-20 x 3/8 

hexagonal-head screw (cap bolt) through the hole in the mast and screw it into the coupler.
Gently tighten the screw with a wrench. Do not over tighten. Over tightening can strip the 
coupler threads or crack the coupler.
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▢ Insert the cable end and coupler into the lower end of the upper mast section.

▢ Coat the upper end of the coupler with moisture-proof insulating lubricant.
▢ Align the threaded hole in the coupler with the hole in the upper mast section. Insert a 1/4-20 

x 3/8 hexagonal-head screw (cap bolt) through the hole in the mast and screw it into the 
coupler.
Note: Gently tighten the screw with a wrench. Do not over tighten. Over tightening can strip 
the coupler threads or crack the coupler.

▢ Gently push the cable toward the top of the mast until it appears at the top.
▢ Coat the cable connector threads and the antenna feed connector threads with moisture-

proof insulating lubricant.
▢ Connect the cable connector to the antenna feed connector. Finger tighten the connectors. 

Do not use a wrench or pliers.
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▢ Apply moisture-proof insulating lubricant to the lower metal section of the antenna feed. Coat 
the areas that will touch the mast when the antenna feed is inserted.

▢ Insert the antenna feed into the upper end of the mast.

The horizontal antenna elements are white fiberglass whips.
Note: Some older SeaSonde models have two-piece antenna elements. Coat the exposed 
metal ferrule with moisture-proof insulating lubricant. Push the two pieces together, ensuring 
they are firmly and completely mated. Wrap the exposed metal coupler where the two pieces 
mate in electrical tape.

▢ Align the threaded holes in the feed with the holes in the mast.
▢ Coat the metal threads of a white fiberglass horizontal antenna whip with non-conducting 

silicone grease (Dow Corning DC-4 recommended).
▢ Insert the antenna element through the mast hole and screw it into the feed. Tighten securely 

using a wrench.

▢ Coat the threads of the second antenna whip with non-conducting silicone grease (Dow 
Corning DC-4 recommended).
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▢ Insert the antenna whip through the mast hole opposite (180 degrees away from) the whip 
previously installed. Screw the whip into the feed by hand to ensure proper thread contact. 
Tighten securely using a wrench.

The vertical antenna element is a green fiberglass whip. The whip is made of four sections for 
11.5-14 MHz transmitters or two sections for 24-27 MHz transmitters. From bottom to top, each 
section is progressively thinner.
▢ Insert each vertical antenna section’s metal coupler into the the next section’s socket. Coat 

the antenna connection with DC-4 silicone grease and push the sections firmly together and 
hand-tighten it

▢ Insert the antenna feed into the vertical antenna element. Twist the pieces firmly and 
completely together by hand. Do not use a wrench or tool.

Assembly of the SeaSonde transmit antenna is now complete.
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Appendix C:

SeaSondeRadialSetup Default Settings:

The following screen shots show the default settings for Standard Radial Site operations and 
data averaging times.

5 MHz Long-Range SeaSonde

12 MHz Standard Range SeaSonde
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25 MHz Standard Range High Resolution SeaSonde

42 MHz Hi-Res SeaSonde
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Appendix D:

Optional Configuration Tasks

Find frequency with least interference

▢ With transmitter off, collect at least one full CSQ file for each of your assigned operating 
frequencies.

▢ Open a CSQ file collected at each frequency using the application SpectraPlotterMap. 
▢ Examine range cell #5 comparing noise floor values on each antenna.
▢ Inspect each range cell for interference striping (horizontal or vertical stripes).
▢ Choose the frequency with the lowest noise and no interference for your primary operating 

frequency.
Create a site map for viewing surface currents
▢ Launch SeaDisplaySetup (/Codar/SeaSonde/Apps/Tools/SeaDisplaySetup)
▢ Pull down File->New to create a new map

▢ Zoom the map in until it covers the area of interest:
• Option + Up arrow/Down arrow keys zooms in and out
• Shift + Left/Right/Up/Down arrows adjust the Left/Right/Up and Down frame boundary
• Left/Right/Up/Down arrows adjusts Left/Right/Up and Down position within the frame
• Choose the View > Map Navigation or View > Speed Hints to see details on navigating the map
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▢ Pull down Map->Sites menu
▢ Click “OK” to dismiss “Sites dialog usage...” help box
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▢ Click “Add” button in “Site Definition”

▢ Replace “Name” box entry “SCrz” with your four-character site name.
▢ Enter latitude and longitude as D.DDDD, DDD MM.MMMM or  DDD MMM S.SS.

Note: Disregard degree-minute-second symbols, make sure to include N,S,E,W as 
appropriate.

▢ Click “More ...” button
▢ Check mark “name” in Labeling options Release7-SeaDisplaySetup-SiteDialog
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▢ Enter expected range in “Coverage display: Max Km”
(Defaults: 15km for 42MHz, 45km for 25MHz, 75km for 12MHz, 185km for 5MHz)

▢ Click “OK” to dismiss “More...” dialog
▢ Click “OK” to dismiss “Site Definition” dialog
▢ Pull down “Map->Title” menu
▢ Enter a title less than 32 characters in the Line 1 text field
▢ Select “Top Center” in the Placement pull down menu

▢ Click “OK” to dismiss “Map Title” dialog
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▢ Pull down “Map->Km Legend” menu
▢ Check “Enable” box
▢ Click “OK” to dismiss “Km Legend” dialog
▢ Pull down “Map->Cm/s Legend...” menu
▢ Check “Enable” box
▢ Adjust “Placement” boxes as needed
▢ Click “OK” to dismiss “Cm/s Legend...” dialog

▢ Pull down “Map->N/S arrow...” menu
▢ Check “Enable” box
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▢ Click “OK” to dismiss “N/S arrow...” dialog
▢ Pull down “Map->Date/Time...” menu
▢ Check “Enable” box

▢ Click “OK” to dismiss “Date/Time” dialog
▢ Pull down File->Save (use default Site File Options) and click OK button

▢ Hyphenate (or delete) any old map files in the SiteDefinitions folder
Note: The first SeaDisplay map file encountered in the SiteDefinitions folder having the name 
format SiteMap_XXXX.smap will be opened automatically when SeaDisplay is launched.

You have now completed a basic map for displaying your radial data. Your completed map 
should look something like this:
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▢ Once you have made a change to the default map, pull down File->Save (use default Site 
File Options)

▢ Enter your four-character site code
▢ Click SAVE button
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